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Chapter 1. Global

Rice Client Overview

Y ou can integrate your application with Rice using several methods, each described below.

Embedded

This method includes embedding some or al of the Rice services into your application. When using this
method, a standalone Rice server for the Rice web application is still required to host the GUI screens and
some of the core services.

To embed the various Rice modules in your application, you configure them in the RiceConfigurer using
Spring. For more details on how to configure the RiceConfigurer for the different modules, please read
the Configuration Section in the Technical Resource Guide for the module you want to embed.

Figure 1.1. Diagram of a sample embedded implementation
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Advantages

* Integration of database transactions between client application and embedded Rice (via JTA)
» Performance: Embedded servicestalk directly to the Rice database

» No need for application plug-ins on the server
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» Great for Enterprise deployment: It's still a single Rice web application, but scalability is increased
because there are multiple instances of embedded services.

Disadvantages
» Can only be used by Java clients
» Morelibrary dependencies than the Thin Client method

» Requires client access to the Rice database

Bundled

This method includes the entire Rice web application and all services into your application. This method
does not require a standalone Rice server.

Each of the Rice modules provides a set of JSPs and tag libraries that you include in your application.
These are then embedded and hooked up as Struts Modules. For more details on how the web portion of
each module is configured, please read the Configuration Guide for each of the modules.

Figure 1.2. Diagram of a sample bundled implementation
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* All the advantages of Embedded Method
» No need to deploy a standalone Rice server

Ideal for development or quick-start applications

» May ease development and distribution

 Can switch to Embedded Method for deployment in an Enterprise environment




Global

Disadvantages
» Not desirable for Enterprise deployment when more than one application isintegrated with Rice

» More library dependencies than the Thin Client method and the Embedded Method (since it requires
additional web libraries).

Thin Java Client

This method utilizes some pre-built classes to provide an interface between your application and web
services on a standalone Rice server.

Many of the Rice services are exposed by the KSB as Java service endpoints. This means they use Java

Serialization over HTTP to communicate. If desired, they can also be secured to provide access to only
those callers with authorized digital signatures.

Figure 1.3. Diagram of a sample Thin Java Client implementation
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Advantages
» Relatively simple and lightweight configuration
» Fewer library dependencies
Disadvantages

» No transactional integration between client and server

* Plug-ins must be deployed to the server if custom Rice components are needed
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Web Services

This means directly using web services to access a standal one Rice server. This method utilizes the same
services as the Thin Java Client, but does not take advantage of pre-built binding code to access those
services.

Advantages

» Any language that supports SOAP web services can be used
Disadvantages

* No transactional integration between client and server

* Plug-ins must be deployed to the server if custom Rice components are needed

» Web Services can be slower than other integration options

Global Configuration Parameters

Table1.1.
Configuration| Description Samplevalue
Parameter
app.code Together with environment, forms the|kr
app.context.name which then forms the
application URL.

application.id | The unique ID for the application. A value
should be chosen which will be unique
within the scope of Kuali Rice deployment
and integration. There is no default for this
value but it must be defined in order for
portions of Kuali Riceto function properly.

application.hogThe name of the application server the|localhost
application is being run on.

application.httpBbegonetocol the application runs over. http

cas.url The base URL for CAS services and pages. | https://test.kuali.org/cas-stg

config.obj.file | The central OJB configuration file.

config.spring.fildsed to specify the base Spring
configuration file. The default vaue
is  "classpath:org/kuali/ricelkew/config/
KEWSpringBeans.xml"

credentialsSourddkeactory  name of the
org.kuali.rice.core.security.credential s.Credential sSourceFactory
bean to use for credentials to cals on the
service bus.

datasource.accesdloladéngindsta source's pool guard|true
ConnectionAllomzedss to the underlying data connection.
See: http://commons.apache.org/dbcp/
apidocs/org/apache/commons/dbcp/
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Configuration| Description Samplevalue
Parameter
BasicDataSource.html
#isAccessToUnderlyingConnectionAllowed()
datasource.initidBze initial number of database|7

connections in the data source pool.
See: http://commons.apache.org/dbcp/
apidocs/org/apache/commons/dbcp/

datasource.min

BasicDataSource.html#initial Size
[l number of connections in
the pool which can be idle

without new connections being created.
See: http://commons.apache.org/dbcp/
apidocs/org/apache/commons/dbcp/
BasicDataSource.html#minldle

7

datasource.ojb.
className

Seheenciigkanaged to manage database
sequences in databases which do not
support that feature. Default value is
"org.apache.ojb.broker.platforms.KualiMy$

5QL SequenceM anagerl mpl*

datasource.poo|

ThexAwtxienum number of connections
alowed in the data source pool.
See: http://commons.apache.org/dbcp/
apidocs/org/apache/commons/dbcp/
BasicDataSource.html#maxActive

50

datasource.poo|

Bree number of connections in the data
source pool; the default is 5.

6

environment

The name of the environment. This will
be used to determine if the environment
the application is working within is a
production environment or not. It is also
used generally to expressthe "name" of the
environment, for instance in the URL.

dev

http.port

The port that the application server uses;
it will be appended to all URLs within the
application.

8080

log4j.settings.p

robe log4j properties of the application, set
up in property form.

log4j .settings.x

mMhe log4j properties of the application, set
up in XML form.

rice.additional

baricwRitesdelimited list of extra Spring files
to load when the application starts.

additional .conf

@locationa delimited list of additional
configuration file locationsto |oad after the
main configuration files have been loaded.
Note that this parameter only appliesto the
Rice standalone server.

rice.custom.ojb

.Phapefiiles where OJB properties for

org/kuali/rice/core/ojb/RiceOJB.properties

the Rice application can be found.
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Configuration| Description Samplevalue
Parameter

The default is "org/kuali/rice/corel/ojb/
RiceOJB.properties’

rice.logging.corfigarenines whether the logging lifecycle|false
should be loaded.

rice.url The main URL to the Rice application. ${ application.url} /kr

security.directafffhe location where security properties|/usr/local/rice/
exist, such as the user name and password
to the database.

transaction.timgbbe length of time a transaction has to| 300000
complete; if it goes over this vaue, the
transaction will be rolled back.

version The version of the Rice application. 03/19/2007 01:59 PM

Rice Service Architecture and Configuration
Overview

This document describes how the Rice Service Architecture operates.

Overview

The Rice System consists of astack of Resourceloader objects that contain configuration information and
expose service implementations (potentially from remote sources). Each module supplies its own Spring
context containing it’s services. These Spring contexts are then wrapped by a Resourcel oader which is
used to locate and load those services.

Implementation Details

Rice is composed of a set of modules that provide distinct functionality and expose various services.
Each module loads it’s own Spring context which contains numerous services. These Spring contexts are
wrapped by a Resourceloader class that provides access to those services. A Resourcel oader is similar
to Spring's BeanFactory interface, since you acquire instances of services by name. Rice adds several
additional concepts, including qualification of service names by namespaces. When the RiceConfigurer
isinstantiated, it constructs a Global Resourcel oader which contains an ordered chain of Resourcel oader
instances to load services from:
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Figure 1.4. Resour ce L oader Stack
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All application code should use the Global Resourcel. oader to obtain serviceinstances. The getService(...)
method iterates through each registered Resourcel oader to locate a service registered with the specified
name. In it’s default configuration, the Global Resourcel. oader contacts the following resource loaders in
the specified order:

1. Spring Resour cel oader —wraps the spring contexts for the various Rice modules
2. Plugin Registry —allows for services and classes from to be loaded from packaged plugins

3. Remote Resourcel oader — integrates with the KSB ServiceRegistry to locate and load remotely
deployed services

As shown above, the last Resourcel oader on the list is the one registered by KSB to expose services
available on the service bus. It's important that this resource loader is consulted last because it gives

priority to using locally deployed services over remote services (if the serviceis available both locally and
remotely). This is meant to help maximize performance.

Accessing Rice Services and Beans Using Spring

Rice Service as a Spring Bean

In addition to programmatically acquiring service references, you can also import Rice services into a
Spring context with the help of the Resourcel oaderServiceFactoryBean:

<l-- inport a Rice service fromthe ResourcelLoader stack -->
<bean i d="aRi ceService" class="org. kuali.rice.resourcel oader. support. ResourcelLoade

This class uses the Global Resourcel.oader to locate a service named the same as the ID and produces a
bean that proxies that service. The bean can thereafter be wired in Spring like any other bean.




Global

Using Annotations

Riceincludes a Spring bean that extends the Spring auto-wire process (unlike the current version of Spring,
the auto-wire process in the version of Spring that’s included with Rice cannot be extended). With this
bean configured into your application, you can use the @RiceService annotation to identify Rice services
to auto-wire.

Add this bean definition to the top of your Spring configuration file to configure the Spring extension:
<bean class="org. kuali.rice.core.util.GRLServicelnjectionPostProcessor"/>

Add the @RiceService annotation to any field or method, following the normal Spring rules for injection
annotations. The annotation requires aname property that specifiesthe name of the serviceto inject. If the
name requires a namespace other than the current context namespace, you must specify the namespace as
aprefix (for example, “{ KEW} actionListService”).

@R ceServi ce( nane="wor kf | owDocunent Ser vi ce")
prot ect ed Wor kfl owDocunent Servi ce wor kf | owDocurnent Ser vi ce;

Publishing Spring Services to the Global Resource Loader

In certain cases, it may be desirable to publish al beans in a particular Spring context to
the Resource Loader stack. Fortunately, there is an easy way to accomplish this using the
RiceSpringResourceloaderConfigurer as shown below:

<I— Publish all services fromthis Spring context to the GRL -->
<bean cl ass="org. kuali.rice.core.resourcel oader. Ri ceSpri ngResour ceLoader Confi gurer

<bean id="myServicel" class="ny.app. package. MyServi cel"/>

<bean id="myServi ce2" class="ny. app. package. MyServi ce2"/>

In the above example, both myServicel and myService2 would be added to a Resource Loader that would
be put at the top of the Resource Loader stack. The names of these services would be “myServicel” and
“myService2” with no namespace. To load these services you would use the following call to the Global
Resource L oader:

MyServi cel nmyServicel = d obal Resour ceLoader. get Servi ce(“nyServicel”);
Customizing and Overriding Rice Services

Reasons for Overriding Services

The most common reason that one would want to override services in Kuali Rice is to customize the
implementation of a particular service for the purposes of institutional customization.

A good example of thisisthe Kuali Identity Management (KIM) services. KIM is bundled with reference
implementations that read identity (and other) data from the KIM database tables. In many cases an
implementer will already have an existing identity management solution that they would like to integrate
with. By overriding the service reference implementation with a custom one, it’ s possible to integrate with
other institutional services (such as LDAP or other services).

Installing an Application Root Resource Loader

An alternative to using the RiceSpringResourcel. oaderConfigurer to publish beans from a Spring context
to the Rice Resource Loader framework is to inject aroot Resource Loader into the RiceConfigurer.
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Y ou can create an implementation of Resourcel oader that returns a custom bean instead of the Rice bean,
or you can use a built-in resource loader like the SpringBeanFactoryResourcel oader which wrapsa Spring
context in a Resourcel oader. Y our configuration needs to inject this bean as the RootResourcel oader of
the RiceConfigurer using the rootResourcel oader property, as shown below:

<l-- a Rice bean we want to override in our application -->
<bean i d="overri ddenRi ceBean" cl ass="nmny. app. package. M\yRi ceServi cel mpl "/ >

<l-- supplies services fromthis Spring context -->
<bean i d="appResour ceLoader"
class="org. kuali.rice.core.resourcel oader. Spri ngBeanFact or yResour ceLoader"/ >

<bean id="rice" class="org.kuali.rice.core.config.R ceConfigurer">
<property nane="r oot Resour ceLoader" ref="appResourcelLoader"/>
</ bean>
Warning

Application Resource Loader and Circular Dependencies

Be careful when mixing registration of an application root resource loader and lookup of Rice
servicesviathe Global Resourcel oader. If you are using an application resource loader to override
aRicebean, but one of your application beans requiresthat bean to beinjected during startup, you
may create a circular dependency. In this case, you have to make sure you are not unintentionally
exposing application beans (which may not yet have been fully initialized by Spring) in the
application resource loader, or you have to arrange for the GRL lookup to occur lazily, after
Spring initialization has completed (either programmatically, or via some sort of proxy).

Replacing Rice Configuration Files
A Rice-enabled web application (including the Rice Standalone distribution) contains a RiceConfigurer
(typicaly defined in a Spring XML file) that |oads the Rice modules. Y ou can override services from the
various modules by injecting alist of additional spring filesto load asin the following example:

<bean id="rice" class="org.kuali.rice.core.config.R ceConfigurer">

<property nane="additi onal SpringFil es" ref="appResourcelLoader">

<list>
<val ue>cl asspat h: ny/ app/ package/ MyCust onpri ngFi | e. xm </ val ue>
</list>

</ property>
</ bean>
Y ou will need to ensure that any Spring XML filesand necessary classesthey reference arein the classpath
of your application. If you are overriding things in the Rice standlone application itself, then you would

need to place classes in the WEB-INF/classes directory of the war and any jars in the WEB-INF/lib
directory.

It's a standard behavior of Spring context loading that the last beans found in the context with a particular
id will be the versions loaded during context initialization. The additional SpringFiles property will put
any Spring files specified at the end of the list loaded by the RiceConfigurer. So any beans defined in that
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file with the same id as beans in the internal Rice Spring XML files will effectively override the out-of-
the-box version of those services.

When working with the packaged Rice standalone server, you won't have access to the Spring XML
file which configures the RiceConfigurer. In this case, you can specify additional spring files using a
configuration parameter in your Rice configuration XML, asin the following example:

<param nane="ri ce. addi ti onal Spri ngFi |l es”
val ue="cl asspat h: my/ app/ package/ MyCust onSpri ngFi |l e. xm "/ >

Eclipse and Rice

Warning
Recent changein Eclipse setup
Due to its unreliability, we have recently stopped relying on the Maven plugin for Eclipse to

manage the project build path. Instead, we are using the eclipse:eclipse plugin for Maven to
generate a static build path. Please note the changes in the Eclipse project setup.

Overview

This document describes how to set up an Eclipse environment for running Rice from source and/or for
developing onthe Kuali Rice project. To create your own Kuali Riceclient application, seetheinstructions
in Creating a Rice-Enabled Application.

Download the Tools

1. Install Java5 SDK - http://java.sun.com.

2. Install the Eclipse Europa Bundle for Java Developers - http://www.eclipse.org/europal

e You need to allocate at least 768MB of memory for the Eclipse runtime and at least 512MB of
memory for the VM that Eclipse uses when it runs Java programs and commands.

» Goto Eclipse Preferences.
* On Windows: Window --> Preferences --> Java --> Installed JRES.
* On Mac OS X: Eclipse --> Preferences --> Java --> Installed JREs.
* Select the JRE and click Edit.
* Add-Xmx768m to Default VM Arguments

3. Install Maven2 for command line usage:
» Download Maven2.0.9 from http://maven.apache.org/download.html.

 Install Maven2 into C:\maven on Windows or /opt/maven on Linux. This directory is called the
Maven Root directory.

* Register Maven on your computer's PATH so that it can be invoked as an executable without have
to run the mvn command from the <maven_r oot>/bin directory all of the time.

10
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» SettheM2 HOM E environment variable on your system to thelocation of your Maven2 installation.
4. Update .m2 repository directory (WINDOWS ONLY) By default (on Windows) maven placesthe.m2

repo directory in the user directory inside the Documents and Settings folder. The space characters

can cause issues. To avoid them we need to do the following:

a. Figure out where you want your local maven repository to be stored, i.e. C:\work\m2

b. Make sure you turn off eclipseif it has auto updating maven turned on.

c. Move everything from your old maven directory to your new one. Thiswill save you a considerable
amount of time. If you do not do thisthen maven will re-download all repositoriesto the new location.

d. Update your settings.xml file. This should be located in C:\Documents and Settingsiuser
\.m2\settings.xml. Add thisline to the file somewhere inside the <settings> tag:

<l ocal Reposi t or y>C: \ wor k\ n2</| ocal Reposi tory>

Import rice into Eclipse as a project (Source distribution
only)

Note

Y ou only need to follow these instructions if you downloaded the source distribution of Rice as
azip file. If you are a contributing developer who will be committing code to CV'S, please skip
this step (Importing rice into Eclipse as a Project) and go to the next one instead.

1. Open Eclipse.

2. Choose File --> Import --> Existing Projects into Workspace.

11
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Finish.

source  distribution to) as the root project directory and  click
E

@N 6 Import
Import Projects —
Select a directory to search for existing Eclipse projects, B‘
-
) Select root directary: | /Java/projects/ricd | srowse.. )
() Select archive file: Browse.,.
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Check out the Rice code (Non-source SVN distribution

only)

Note

Y ou do not need to perform the stepsin thissection if you have downl oaded the source distribution
of Riceasazipfile.

1. Werecommend installing Subclipse as a plugin from your Eclipse instance (http://subclipse.tigris.org/
install.html)

2. Set up anew SVN repository in Eclipse: https://test.kuali.org/svn/rice

3. Check out the Rice code from the appropriate branch of code (i.e. branches/rice-rel ease-1-0-0-br)

Set up database drivers

Oracle

1. If thisis the first time you've set up Eclipse to work with Rice, Maven won't find the Oracle drivers
in the Kuali repository.

2. If you do not aready have an Oracle driver saved in /java/drivers as ojdbcl4.jar, you can download
one from http://www.oracle.com/technol ogy/software/tech/java/sglj_jdbc/index.html. Saveit as/java/
drivers/ojdbcl4.jar

3. Run this command from the command line (this should al be on one line when you enter it):
UNIX

m/n install:install-file -Dgroupld=comoracle -Dartifactld=ojdbcl4d
- Dversion=10. 2. 0. 3.0 - Dpackagi ng=jar -Dfile=/javal/drivers/ojdbcl4.jar

Windows

nvn install:install-file -Dgroupld=comoracle -Dartifactld=0jdbcl4

-Dversion=10.2.0. 3.0 -Dpackaging=jar -Dfile=c:/javal/drivers/ojdbcld.jar

Or, run the equivalent Ant target:

ant install-oracle-jar

Other databases

Thedriver for MySQL is already referenced by the Kuali Rice project. Rice does not have out-of-the-box
support for other RDBMS at this point in time. However, if you want to use other databases, it is possible
to add database support for that particular database as long as it’s supported by the Apache OJB project
(http://db.apache.org/ojb).

Set up Eclipse for Maven

If this is the first time you are using Eclipse with a project build path generated by the eclipse:eclipse
Maven plugin, you need to define the M 2_REPO Classpath Variable in your Eclipse: Java > Build Path
> Classpath Variable, under the Preferences menu.
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The Rice project contains auto-generated build path entries that rely on the presence of this M2_REPO
variable to determine the location of dependency libraries.

Rebuild Rice

1. If dependency libraries have been added or removed from the Rice project, including the first time you
check out Rice, you should run the retrieve-maven-dependencies Ant target to pull down all necessary
libraries.

Note

For the Maven2 Ant tasks to work, Ant has to know where your Maven2 homeis. If you have
set the M2_HOME variablein your system environment, it will be recognized automatically.
If not, or if for some reason you want to use a different location (e.g., if you want to have
multiple Maven installations), then you can set the maven.home.dir ectory property in/home/
ubuntu/kuali-build.properties.

2. Add the build.xml file in the root of the Rice project to your Ant view, or open a shell to the Rice
project directory and run the retrieve-maven-dependenciestarget. Y ou should see Maven retrieving any
required dependencies. If you are running this Ant task in Eclipse, then you must recognize the PATH
environment variable under Run > External Tools > Open External Tools Dialog > Environment.
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3. Optionaly, if you have trouble running this Ant target, you can just run an mvn compile from the
command line to invoke a Maven compilation. This will download all dependencies into your local
maven repository.

4. Execute aclean build of the project in Eclipse:
rch Run Window Help

agd!
[

'
o

Build Working Set (3

v Build Automatically

2 Generate Javadoc...

_

5. If your build was previously broken due to the M2_REPO classpath variable being undefined or due
to missing libraries, it should now have been built successfully.

Install the database

To set up the database, please follow the instructions in the Installation Guide under Preparing the
Database.

Installing the appropriate configuration files

Note

Be sure to use an appropriate editor such as vi or Notepad when editing configuration files. For
example, we have found that WordPad can corrupt the configuration file.

To ingtall the configuration file for the Kuali Rice sample application, you can do an Ant-based setup or
amanual setup.

Ant-based setup
1. Executetheprepare-dev-environment Ant target inthebuild.xml filelocated in theroot of the project.
2. Thiscreates: <user home>/kuali/main/dev/sample-app-config.xml

Manual setup

1. Copy the configitemplates/sample-app-config.templatexml file to <user home>/kuali/main/dev/
sample-app-config.xml.
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 For Windows, your user homeis: C:\Documents and Settings\<user name>

» For Unix/Linux, your user homeis:

/home/<user name>

» For Mac OS X, your user homeis. /User g/<user name>

2. Add the appropriate database parameters to <user home>/kuali/main/dev/sample-app-config.xmi

* Oracle

<par am nanme="dat asour ce.
<par am nanme="dat asour ce.
<par am nanme="dat asour ce.

* MySQL

<par am nane="dat asour ce.
<par am nane="dat asour ce.
<par am nane="dat asour ce.

url">j dbc: oracl e: thin: @ocal host: 1521: XE</ par an»
user name" >or acl e. user nane</ par ane
passwor d" >or acl e. passwor d</ par an®

url " >jdbc: nysql ://1 ocal host: 3306/ kul ri ce</ par an»
user nanme" >nysql . user nane</ par ane
passwor d" >nysql . passwor d</ par an®

Run the sample web application

» Back in Eclipse, locate and run the rice - JettyServer.launch file:

¥ S sLrigs
¥ Ly grooey- 10
¥ o laumch
TR = TR i Pl o Rl Rt et Sl i
§ FRCE = M i Mew -
e - e Open F3
::: :::: Open With b
F o maven-am-rasks =i In LREW -
F o upgrades 'I:I:I[J'p' T
| CFEHIEEOjECL g
| doallgroovy 310 =
| OBdrOEs ooV | Paste wv
| dbmerge.groovy K Delete = 1
LR T
| setenvbat 1912 * problems | @ Javadoc Declaraticn
[ seremsh 1912 & - ! l
| wmialgroovy 310 Build Path -
B pECufily Refactor WRT E
* % shared
F 5 standalone iy Import...
B Lo targed &5 Export...
B testharndss
> T toaly Refresh F5
¥ buad xemil 3054 1770, Assign Working Sets. .
| LBCERSE bt 0G4 12 Validate

¥, pom.xenl 3275 27154

| READMEDct 1912 & S s £ 1 rice - JettyServer

S r a9, 3 [hrancRies e e

Debug As -

Mo Dl & .

23 Runa An LEfnsr SVY B

* Point your browser to the following url: http://localhost:8080/kr-dev
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Changing Rice project dependencies

If you change any of the dependenciesin any of the Rice pom.xml files, you must run the update-eclipse-
classpath Ant target to regenerate the top-level Eclipse .classpath file for the project.
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If you change the dependencies and commit the change, when others update their local source copy they
must run the corresponding retrieve-maven-dependencies target again.

Note

Refresh your Eclipse project if dependencies (and therefore the Eclipse.classpath file) have
changed.

Other Notes

Settings.xml warning

If thisis the first time that you have installed the Maven plugin into your Eclipse environment, you may
need to add afile called settings.xml in your <user home>/.m2 directory.

The easiest way to tell if you need to do thisis that there will be awarning in the console after building,
stating that the settings.xml fileismissing. All you need to dois create a settings.xml file with this content:

<settings/>

Rebuild, and the warning should no longer appear.

Note

You do NOT ever need to run any of the context menu Maven commands from inside Eclipse.

You do NOT need to run any Maven commands from the command line.
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The Eclipse Maven2 plugin is a little bit flaky sometimes. Y ou might need to close Eclipse to
flush its memory.

Default workspace JDK not 1.5

If your default workspace JDK is not 1.5, you need to reconfigure the Maven external tools definitions
for Rice thisway:

1. Open Run->External Tools->External Tools Dialog... menu item.
2. Find the m2 build category.

3. Select each preconfigured Rice external tool configuration, select the JRE tab, and ensure the JRE is
setto 1.5.

Using a custom maven repository location

The default Maven2 repository location is in your user directory; however, if you have a pre-existing
repository (or for some other reason don't want it in your user directory), you can alter Maven2'srepository
location. The current version of the Maven2 plugin has a bug that does not allow this to work (see http://
jira.codehaus.org/browse/MNGECL IPSE-314), but the 0.0.11 development version available from the
update site http://m2eclipse.codehaus.org/update-dev/ allows you to specify a custom local repository.

Note

If you make this change, you may have to delete and re-add the Maven Managed Dependencies
library to your project build path if you have an existing, invalid, Maven-managed dependencies
library.

Setting JDK Compliance version

If your default workspace JDK is not 1.5, then you also need to set the JDK compliance level to the
appropriate version for the project. You can find this by right-clicking on the Project -> Properties ->
Java Compiler -> Compiler compliance level. Be sure the Enable project specific settings checkbox is
checked.

Turn off validation

Be sureto turn off validation at the project level by right-clicking on the Project, then clicking Properties
-> Validation -> Suspend all Validators. This can be adjusted once a successful Rice project is up and
running.

ORA-12519, TNS:no appropriate service handler found

If you start seeing java.sql.SQL Exception: Listener refused the connection with thefollowing error:
ORA-12519, TNS:no appropriate service handler found, there are a couple of things that may remedy
the problem.

1. Increase the Oracle XE connection limit:

alter system set processes=150 scope=spfile;
alter system set sessions=150 scope=spfil e;

2. Lower the Atomikos pool sizein your rice config.xml:
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<par am nane="dat asour ce. pool . si ze" >10</ par an®

Disconnect any other clients and then restart Oracle-XE.

Creating Rice Enabled Applications

Creating a Rice Client Application Project Skeleton

The Kuali Rice source code comes with a script (written in alanguage called Groovy) which will create a
skeleton client application project that bundles Rice. If you do not have Groovy installed on your machine,
you will need to download and install it from http://groovy.codehaus.org/

Preparation Steps
To get ready to run the script:
1. Open ashell window or command prompt window.

2. Change your current directory to the scripts directory within the Rice source code tree (for example,
if you unpacked the source code into a directory named /java/projectgrice, you want to navigate to
ljavalpr ojects/rice/scripts).

3. If the Groovy interpreter is not on your command path (entering the command groovy results in an
error stating that the command was not found), enter the command: . ./setenv.sh in Unix or setenv.bat
in Windows.

4. Verify that you have Groovy installed by typing the command gr oovy at the comment line. Thisshould
print out the groovy usage message.

Command Syntax

Enter groovy createproject.groovy followed by one or more of the following parameters, separated by
spaces:

» -name defines the name of the project. It must be followed by a space and the desired project name.
The project name should consist of letters, numbers, dashes, and underscores only. This parameter is
required.

» -pdir specifiesthe directory to hold the new project. It must be followed by a space and the directory.
A directory named the same as the project name will be created in this directory. If not specified, the
directory /java/pr ojects will be used.

 -rdir specifiesthedirectory containing the Rice project. It must befollowed by aspace and thedirectory.
If not specified, the directory /javalprojects/rice will be used.

» -mdir specifiesthe home directory for Maven, whichisrequired to set up the Eclipse project’ sclass path
information. It must be followed by a space and the directory. If not specified, the script will attempt
to find Maven using the following sources:

« Anenvironment variable named M2 HOME
¢ An environment variable named m2.home

A property named maven.home.directory in thefile kuali build.propertiesin your home directory
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» -sampleapp requests the sample application to be included in the new project. This can serve as an
example for building a Rice application. If not specified, the sample application is not included.

» -standalone requests the client project be set up to be run with a standalone rice server. This sets the
default configuration files to containing the necessary settings to connect to standalone rice. The rice
url and database properties will still need be updated manually.

Sample Script Execution

groovy createproject.groovy -nanme MyFirstProject -sanpleapp

Further instructions on how to open the project and run it will be printed to the console when the script
has finished executing. At this point, you now have a skeleton of a Kuali Rice client application that you
can use to begin building your own application. However, before running the application, you will need to
create a Rice database (if you’ re using the sampleapp, you' |l need to set up the demo database; otherwise,
you'll set up a stripped-down bootstrap database).

The configuration of this application uses a bundled model where the Rice server and client pieces are
all being included and loaded by your sample application. Thisis useful for development purposes since
it makes it very easy to get the application running. It is not recommended for an enterprise deployment
where you may want to have more than one application integrating with Kuali Rice. In these cases, you
would want to install and integrate with a Standal one Rice server. For more information on installing and
configuring a standal one server, see the Installation Guide.

Reorder Eclipse Classpath

Once the sample script execution has completed, you will need to import your project into eclipse and
reorder the eclipse classpath to account for a change in how the classpath was generated by maven.
Navigate to your project properties and select the Order and Export tab from the Java Build Path project
property. There will be an entry for JRE System Library at the bottom of the list that should be moved
to the very top.

Rice Configuration System

The Rice Configuration System is an XML-based solution which provides capabilities similar to Java
property files, but aso adds some additional features. The configuration system lets you:

» Configure keys and values

» Aggregate multiple files using a single master file

* Build parameter values from other parameter values
» Use the parametersin Spring

» Override configuration values

Configuring Keys and Values

Below is an example of aconfiguration XML file. Note that the white space (spaces, tabs, and new lines)
is stripped from the beginning and end of the values.

<confi g>
<param nane="clientl.| ocati on">/opt/jenkins-hone/jobs/rice-trunk-site-depl oy/w
<param nane="cl i ent 2.1 ocati on">/ opt/j enki ns- hone/jobs/rice-trunk-site-depl oy/w
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<par am nane="ksb. cl i ent 1. port " >9913</ par an»

<par am nane="ksb. cl i ent 2. port " >9914</ par an®

<par am nane="ksb. t est har ness. port">9915</ par anv

<par am nane="t hr eadPool . si ze" >1</ par an®

<par am nane="t hr eadPool . f et chFr equency" >3000</ par an®

<par am nane="bus. refresh. rat e">3000</ par an®

<par am nane="keystore. al i as">ri ce</ par anp

<par am nane="keyst or e. passwor d" >super - secr et - pw</ par anp

<par am nane="keystore.fil e">/opt/jenkins-hone/jobs/rice-trunk-site-depl oy/work
</ config>

Here is an example of the Java code required to parse the configuration XML file and convert it into a
Properties object:

Config config = new Si npl eConfig(configlLocations, properties);
confi g. parseConfig();

In the sample above, configlocations is a List<String> containing file locations using the standard
Spring naming formats (examples: file:/whatever and classpath:/whatever). The variable propertiesisa
Properties object containing the default property values.

Hereis an example of retrieving a property value from Java code:

String val = ConfigContext.getCurrent ContextConfig().getProperty(“keystore.alias”)
Aggregating Multiple Files

The Rice Configuration System has a specia parameter, config.location, which you use to incorporate
the contents of another file. Typically, you use this to include parameters that are maintained by system
administratorsin secure locations. The parametersin the included file are parsed asif they had been in the
original file at that place. Here is an example:

<confi g>
<param nane="config.location">file:/my_secure_dir/my_secure_file.xm </ paranp
</ config>

Building Parameter Values from Other Parameters

Once you have defined a parameter, you can use it in the definition of another parameter. For example:

<confi g>

<par am nane="appl e">red del i ci ous</ par anr

<par am nane="t ast e" >yumy yunmy</ par anp

<par am nane="appl e. t ast e">${ appl e} ${taste} </ paranpr
</ config>

When this example is parsed, the value of the parameter apple.taste will be set to red delicious yummy
yummy.

Using the Parameters in Spring

Because the parameters are converted into a Properties object, you can retrieve the complete list of
parameters using this code:

confi g. get Properties()
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You typically use this in Spring to parse a configuration and put its properties in a
PropertyPlaceHolderConfigurer so that the parameters are available in the Spring configuration file:

<bean id="config" class="org. kuali.rice.core.config.spring.ConfigFactoryBean">
<property nane="configlLocations">
<list>
<val ue>cl asspat h: my-confi g. xm </ val ue>
</list>
</ property>
</ bean>

<bean id="configProperties"
cl ass="org. spri ngframewor k. beans. fact ory. confi g. Met hodl nvoki ngFact or yBean" >
<property nane="target Object" ref="config" />
<property nane="t ar get Met hod" val ue="get Properties" />
</ bean>

<bean cl ass="org. spri ngfranework. beans. factory. config. PropertyPl acehol der Confi gure
<property nane="properties" ref="configProperties" />
</ bean>

Once this is complete, the configuration parameters can be used like standard Spring tokens in the bean
configurations:

<bean i d="dat aSource" class="org. kuali.rice.core. dat abase. XAPool Dat aSour ce" >
<property nane="transacti onManager" ref="jotnt />
<property name="driverCd assNanme" val ue="${dat asource. driver.nane}" />
<property name="url" val ue="${datasource.url}" />
<property name="maxSi ze" val ue="${dat asour ce. pool . naxSi ze}" />
<property name="m nSi ze" val ue="${dat asour ce. pool . m nSi ze}" />
<property name="maxWai t" val ue="${dat asource. pool . maxWait}" />
<property name="val i dationQuery" val ue="${dat asource. pool . val i dati onQuery}" />
<property name="usernane" val ue="${dat asource. usernane}" />
<property name="password" val ue="${dat asource. password}" />

</ bean>

Initializing the Configuration Context in Rice

The Config object can beinjected into the RiceConfigurer that’s configured in Spring and it will initialize
the configuration context with those configuration parameters.

Thisisdone asfollows:

<bean id="config" class="org.kuali.rice.core.config.spring.ConfigFactoryBean">
</ bean>

<bean id="rice" class="org.kuali.rice.core.config.R ceConfigurer">

<property nane="root Config” ref="config”/>
</ bean>

Overriding Configuration Values

The primary purpose of overriding configuration values is to provide a set of default values in a base
configuration file and then provide a separate file that overrides the values that need to be changed. You
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can also update a parameter value multiple times in the same file. Parameter values can be changed any
number of times; the last value encountered while parsing the file will be the value that is retained.

For example, when parsing the file:

<confi g>
<param nane="t ast e" >yummy yunmny</ par anp
<par am nane="t ast e" >good st uff</paranp
</ config>

The final value of the parameter taste will be good stuff since that was the last value listed in the file.
As another example, when parsing the file:

<confi g>
<param nane="t ast e" >yumy yunmny</ par anp
<par am nane="appl e. t ast e">appl e ${t aste} </ paranr
<par am nane="t ast e" >good st uff </ paranp

</ config>

The final value of the parameter apple.taste will be apple yummy yummy. This demonstrates that
parameters that appear in the value are replaced by the current value of the parameter at that point in the
configuration file.

Additionally, you can define certain parameters in such that they won't override an existing parameter
valueif it'salready set.

As an example of this, consider the following configuration file:

<confi g>
<param nane="t aste" override="fal se”>even yumm er </ par anp
<par am nane="br and. new. paranf override="fal se”>brand new val ue</ par an

</ config>

If this file was loaded into a configuration context that had already parsed our previous example, then
it would notice that the taste parameter has aready been set. Since override is set to false, it would
not override that value with even yummier. However, since brand.new.param had not been defined
previoudly, it's value would be set.

Data Source and JTA Configuration

The Kuali Rice software require a Java Transaction API (JTA) environment in which to execute database
transactions. Thisallowsfor creation and coordination of transactionsthat span multiple datasources. This
feature is something that would typically be found in a J2EE application container. However, Kuali Rice
is designed in such away that it should not require a full J2EE container. Therefore, when not running
the client or web application inside of an application server that providesa JTA implementation, you must
provide one. The default JTA environment that Kuali Rice uses is JOTM. There are other open-source
optionsavailable, such as Atomikos TransactionsEssentials, and there are al so commercial and open source
JTA implementations that come as part of an application server (i.e. JBoss, WebSphere, GlassFish).

If installing Rice using the standalone server option and afull Java application server is not being utilized,
then the libraries required for JTA will need to be moved to the serviet server which is being used.
These libraries have aready been retrieved by Maven during project set up; it is a simple matter of
moving them from the Maven repository to the libraries directory of the servlet server. Assuming, for
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instance, that Tomcat is being used, the following files need to be copied from the Maven repository to
$TOMCAT_HOME/common/lib:

» {Maven repository home}/repository/javax/transaction/jta/1.0.1B/jta-1.0.1B.jar

» {Maven repository home}/repository/jotm/jotm/2.0.10/jotm-2.0.10.jar

» {Maven repository home}/repository/jotm/jotm_jrmp_stubs/2.0.10/jotm_jrmp_stubs-1.0.10.jar
« {Maven repository home}/r epository/xapool/xapool/1.5.0-patch3/xapool-1.5.0-patch3.jar

» {Maven repository home}/repository/howl/howl-logger/0.1.11/howl-logger-0.1.11.jar

« {Maven repository home}/repository/javax/r esour ce/connector -api/1.5/connector -api-1.5.jar

» {Maven repository home}/repository/javax/r esour ce/connector/1.0/connector-1.0.jar

» {Maven repository home}/r epositor y/or g/obj ectweb/car ol/car ol/2.0.5/car ol-2.0.5.j ar

Additionally, the{Rice pr oject home}config/jotm/car ol.pr oper ties configuration file needs to be moved
to STOMCAT_HOME/common/classes, this time from the built Rice project.

Configuring JOTM

Configurethe JOTM transaction manager and user transaction objectsas Spring beansin your application’s
Spring configuration file. Here is an example:

<bean id="jotnm class="org.springframework.transaction.jta.JotnfFactoryBean">
<property nane="defaul t Ti neout” val ue="3600"/>
</ bean>

<alias nane="jotn alias="jtaTransacti onManager"/>
<alias nane="jotn alias="jtaUserTransaction"/>

Y ou can use these beansin the configuration of Spring’sJTA transaction manager and the Rice configurer.
This configuration might look like the following:

<bean id="spri ngTransacti onManager" cl ass="org.springfranework.transaction.jta.Jta
<property nane="user Transacti on">
<ref |ocal ="user Transaction" />
</ property>
<property nane="transacti onManager" >
<ref |ocal ="jtaTransacti onManager" />
</ property>
</ bean>

<bean id="rice" class="org.kuali.rice.core.config.R ceConfigurer">
<property nane="transacti onManager" ref="jtaTransacti onManager" />
<property nane="user Transaction" ref="jtaUser Transaction" />
</ bean>
Configuring Transactional Data Sources

JTA requires that the datasources that are used implement the XADataSource interface. Some
database vendors, such as Oracle, have pure XA implementations of their datasources. However,

24



Global

internaly to Rice, we use wrappers on plain datasources using a library called XAPool. When
configuring transactional data sources that will be used within JOTM transactions, you should use the
org.kuali.rice.core.database.X APool DataSource class provided with Rice. Hereis an example of a Spring
configuration using this data source implementation:

<bean i d="nmyDat aSource" class="org.kuali.rice.core. database. XAPool Dat aSour ce" >

<property
<property
<property
<property
<property
<property
<property
<property
<property
</ bean>

nane="transacti onManager" ref="jtaTransacti onManager" />
name="dri ver Cl assNane" val ue="${dat asource.driver.nane}" />
nanme="url" val ue="${datasource.url}" />

nane="nmaxSi ze" val ue="%${dat asour ce. pool . nexSi ze}" />
nane="m nSi ze" val ue="%${dat asource. pool . mi nSi ze}" />
name="maxWai t" val ue="${dat asour ce. pool . max\Wait}" />
name="val i dati onQuery" val ue="${dat asource. pool . val i dati onQuery}"
nane="user nane" val ue="${dat asource. usernane}" />

nane="password" val ue="${dat asource. password}" />

Configuring Non-Transactional Data Sources

When using the built-in instance of the Quartz scheduler that Rice creates, you will need to inject a non-
transactional data source into the RiceConfigurer in addition to the JTA transactional instance. This is
to prevent deadlocks in the database and is required by the Quartz software (the Quartz web site has
an FAQ entry with more details on the problem). Here is an example of a non-transactional data source

configuration:

<bean i d="nonTransacti onal Dat aSour ce"
cl ass="or g. apache. conmons. dbcp. Basi cDat aSour ce" destroy- net hod="cl ose">

<property
<property
<property
<property
<property
<property
<property
<property
<property

name="dri ver C assNane" val ue="${dat asource. driver.nane}"/>
nanme="url" val ue="${datasource.url}"/>

nane="nmaxActi ve" val ue="${dat asource. pool . maxActive}"/>
nanme="m nl dl e" val ue="7"/>

nane="initial Size" value="7"/>

name="val i dati onQuery" val ue="${dat asource. pool . val i dati onQuery}"/>

name="user nane" val ue="${dat asource. usernane}" />
name="password" val ue="${dat asource. password}" />
nane="accessToUnder | yi ngConnecti onAl | owed"

val ue="${dat asour ce. dbcp. accessToUnder | yi ngConnect i onAl | owed}"/ >

</ bean>

Y ou need to either inject this non-transactional data source into the Quartz SchedulerFactory Spring bean
(if you are explicitly defining it) or into the rice bean in the Spring Beans config file as follows:

<bean id="rice" class="org.kuali.rice.config.R ceConfigurer">

<property nane="nonTransacti onal Dat aSour ce" ref="nonTransacti onal Dat aSource" /

</ bean>
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Chapter 2. KEN

KEN Overview
What is KEN?

Kuali Enterprise Notification is a form of communication between distributed systems that allows
messages to be sent securely and consistently. These messages act as notifications upon receipt and are
processed asynchronously within the service layer. The following architectural diagram represents the
flow of messagesin atypical Rice Environment.

Figure2.1. KEN Message Flow
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From a developer’s perspective the diagram below helps to represent the inner workings of how KEN
stores data from the Data Modeling Layer into the Persistence Layer.
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Figure 2.2. KEN Message Storage

ety Brosvsaer
&
T e
HTML = 055
- r F '“"‘w.r 1
Huiah Misrstam. Syslom + JSP + JETL | Lay
- —4 Sperin
Siruls !
LA ]
3 i
T
Sereioes
B Creslanal & Kol
Oitjiscts e Spring '-.--.I-:::'-_-:. Bisiingss
N [Bagei Rubig, gl Lo b Ly
[POUOSE, &) Agithorization, e |
[
L [
b ]
[ " LATE ]
A —— 'Eq.ql"l-, L T Do arszads |
Eymie Layer
CUB (ORM) Cusiodm mgls
't v =
.-""j
" - o —
—t_r r
KEH
Mt Sereices [ K5E Peraisbinco
AT W 25 2] Layer
Dt Sacsra e

The following sections of documentation aim at describing the inner workings of KEN as well as how
those pieces interact with Rice, specifically KEW. KEN itself is an interface that sits on top of KEW’s
API. Thisallowsfor registration and publishing of notifications, which then flow through KEW toresultin
aKEW action request. See KEW Overview for more information. In addition to the action list, KEW can
be optionally configured to forward these requests to the Kuali Communi cations Broker or KCB for short.
Thismoduleislogically related to KEN and handles dispatching messages based on the user preferences.
Once messages are dispatched, aresponse or acknowledgement can be created.

KEN Configuration Parameters

Table2.1. KEN Core Parameters

Configuration Parameter Description Default value

ken.url The base URL of the KEN|${application.url}/ken
webapp; this should be changed
when deploying for external
access
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Configuration Parameter Description Default value

notification.resolveM essageDel i vt bslstadt aetlawgl Gyivihss) of the job 5000
that resolves message deliveries

notification.resol veM essageDel i veii beloitantal (ahvhS) between runs| 10000
of themessage delivery resolution
job

notification.processA utoRemoval JoihatstaRDeleldyl 8n ms) of the job | 60000
that auto-removes messages

notification.processA utoRemoval Jolnéritesersidii®n ms) between runs| 60000
of the message auto-removal job

notification.quartz.autostartup | Whether to automatically start the|true
KEN Quartz jobs

notification.concurrent.jobs Whether the invocation of a|true
KEN Quartz job can overlap
another KEN Quartz job running
concurrently

ken.system.user The principal name of the|notsys

user that KEN should use
when initiating KEN-originated
documents

kcb.url The base URL of the KCB|${application.url}/kcb

(notification broker) webapp
kcbh.messaging.synchronous Whether notification messages|false

are processed synchronously
kch.messageprocessing.startDelayNii® start delay (in ms) of the|50000

job that processes notification

messages
kcb.messageprocessing.repeati nterVad/M iterval  (in ms)  between | 30000

runs of the notification message

processing job
kcb.quartz.group Group name of the KCB Quartz| KCB-Delivery

job
kcb.quartz.job.name Name of the KCB Quartz job M essageProcessingJobDetail
kch.maxProcessAttempts Maximum number of times that|3

KCB will attempt to process a

notification message
notification.processUndeliveredJoii imeatepdetlime, in milliseconds, | 10000

between runs of the KEN process

undelivered notifications job.
notification.processUndeliveredJol stariBesadd @e, in milliseconds, | 10000

between the stat of the
application and the first run of
the KEN process undelivered

notifications job.
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Note

Asof Rice 1.0.1, The parameter kch.smtp.host is no longer used. The smtp server settings that
are required for sending email notifications with KEN are documented in the Kuali Enterprise
Workflow (KEW) Technical Reference Guide under Email Configuration.

KEN Channels

A KEN Channel is correlated to a specific type of notification. An example of a Channel’ s use may be to
send out information about upcoming Library Events or broadcast general announcements on upcoming
concerts. Channelsare subscribed to in the act of receiving notificationsfrom apublisher or producer. They
can a so be unsubscribed to and removed from the data store from within the Ul. The Channel Definitions
are stored in the database table KREN_CHNL _T. The columns are listed as follows:

Table2.2. KREN_CHNL_T

Column Description

CHNL_ID Identifier for the Channel

NM Name of the Channel represented in the Ul

DESC_TXT Description of the Channel

SUBSCRB_IND Determines if the Channel can or cannot be
subscribed to from the Ul. This aso determines if
the channel will be displayed in the Ul

VER_NBR Version Number for the Channel

Channel Subscription

Channels can be subscribed to through the Ul and also through the direct access to the data store. To
add a channel that can be subscribed to simply run the following SQL statement against the data store
customizing value entries to your needs:

| NSERT | NTO KREN_CHNL_T (CHNL_I D, DESC_TXT, NM SUBSCRB_| ND, VER_NBR)

VALUES (2,' This channel is used for sending out infornmation about Library Events
1)

KEN Producers

A KEN Producer submitsnotificationsfor processing through the system. An example of a Producer would
be amailing daemon that represents messages sent from a University Library System.

Characteristics of a Producer:
 Producers create and send notifications to a specific destination through various Channels.
» Each Producer contains alist of Channelsthat it may send notifications to.

» Producer Definitions are stored in the database table KREN_PRODCR_T.
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Table2.3. KREN_PRODCR_T

Column Description

CNTCT_INFO The email address identifying the Producer of the
Notification.

DESC_TXT A Description of the Producer.

NM Name of the Producer.

PRODCR _ID The Producer's Channel Identifier. See the

KREN_CHNL_PRODCR T table found in the
database for more information on how Producers
link to Channels.

VER_NBR Version Number for the Producer.

Adding Producers

The Producer can be added through direct access to the data store. To add a Producer run the following
SQL statement against the data store customizing value entries to your needs:

| NSERT | NTO KREN_PRODCR_T ( CNTCT_I NFO, DESC_TXT, NM PRODCR_I D, VER_NBR)
VALUES (' kuali-ken-testing@ornell.edu' ,'This producer represents nessages sent

KEN Content Types

Overview

A Content Type is part of the message content of a notification that may be sent using KEN. It can be as
simple as a single message string, or something more complex, such as an event that might have a date
associated with it, start and stop times, and other metadata you may want to associate with the notification.

KEN isdistributed with two Content Types. Simple and Event.
Warning

It is strongly recommended that you leave these two Content Types intact, but you can use them
as templates for creating new Content Types.

Every notification sent through KEN must be associated with aregistered Content Type. Registration of
Content Types requires administrative access to the system and is described in the KEN Content Types

section in the User Guide. The rest of this section describes the Content Type attributes that are required
for registration.

Content Type Attributes

A Content Typeis represented as a NotificationContent business object and consists of several attributes,
described below:

id - Uniqueidentifier that KEN automatically creates when you add a Content Type

name - Thisis a unique string that identifies the content. For example, ItemOverdue might be the name
used for a notification Content Type about an item checked out from the campus library.

30



KEN

description - Thisisamore verbose description of the Content Type. For example, "Library item overdue
notices' might be the description for [temOverdue.

namespace - This is the string used in the XSD schema and XML to provide validation of the content,
for example, natification/ContentTypeltemOverdue. The XSD namespace is typically the name attribute
concatenated to the notification/ContentType string. Note how it is used in the XSD and XSL examples
below.

xsd - The X SD attribute contains the complete W3C XML Schema compliant code.

<?xm version="1. 0" encodi ng="UTF-8"?>
<I-- This schema defines a generic event notification type in order for it to be a
<schema xm ns="http://ww. w3. or g/ 2001/ XM_Schema"
xm ns:c="ns:notification/comon”
xm ns: ce="ns: notification/ContentTypeltenOverdue”
t ar get Namespace="ns: notifi cati on/ Cont ent Typel t enOver due”
attri but eFor nDef aul t ="unqual i fi ed”
el ement For mDef aul t ="qual i fi ed">
<annot at i on>
<document ation xml : | ang="en">ltem Overdue Schena</docunentati on>
</ annot ati on>
<i nport namespace="ns: notification/commobn” schemalLocati on="resource: notifi cat

<l-- The content elenent describes the content of the notification. It conta
<el enment nane="content">
<conpl exType>
<sequence>
<el enent name="nessage" type="c:LongStringType"/>
<el enent ref="ce:event"/>
</ sequence>
</ conpl exType>
</ el enent >

<I-- This is the itenoverdue element. It describes an item overdue notice con
<el ement nane="itenoverdue">
<conpl exType>
<sequence>
<el enent name="sunmmary" type="c: NonEnptyShort StringType" />
<el enent name="descri ption" type="c: NonEnptyShortStri ngType" />
<el enent nanme="I| ocation" type="c: NonEnptyShortStringType" />
<el enent name="dueDat e" type="dateTi me" />
<el enent name="fine" type="decimal" />
</ sequence>
</ conpl exType>
</ el ement >
</ schema>

xdl - The XSD attribute contains the complete XSL code that will be used to transform a notification in
XML to html for rendering in an Action List

<?xm version="1. 0" encodi ng="UTF-8"?>

<l-- style sheet declaration: be very careful editing the follow ng, the
default namespace must be used otherw se elenents will not match -->
<xsl : styl esheet
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version="1.0"

xm ns: xsl ="http://ww. w3. org/ 1999/ XSL/ Tr ansf or nf

xm ns: n="ns: notification/Content TypeEvent"

xm ns: xsi ="http://ww. w3. or g/ 2001/ XM_Schema- i nst ance"

xsi : schemalLocati on="ns: notifi cati on/ Content TypeltenOverdue resource: notificat
exclude-result-prefixes="n xsi">

<l-- output an htm fragnment -->
<xsl :out put nethod="htm " indent="yes" />

<l-- match everything -->
<xsl:tenplate match="/n:content" >
<tabl e class="bord-all">
<xsl :apply-tenpl ates />
</t abl e>
</ xsl : tenpl at e>

<l-- match nessage elenment in the default namespace and render as strong -->
<xsl:tenpl ate match="n: nessage” >
<capti on>

<strong><xsl : val ue- of sel ect=".
</ caption>
</ xsl : tenpl at e>

di sabl e- out put - escapi ng="yes"/></stro

<I-- match on itenoverdue in the default nanespace and display all children --
<xsl:tenplate match="n:itenoverdue">
<tr>

<td cl ass="t hnormal "><strong>Summary: </strong></td>
<td cl ass="t hnormal "><xsl : val ue-of sel ect="n:summary" /></td>
</tr>
<tr>
<td class="thnormal "><strong>ltem Description: </strong></td>
<td cl ass="t hnormal "><xsl : val ue-of sel ect="n:description” /></td>
</tr>
<tr>
<td class="t hnormal "><strong>Li brary: </strong></td>
<td cl ass="t hnormal "><xsl : val ue- of select="n:location” /></td>
</tr>
<tr>
<td cl ass="t hnormal "><strong>Due Date: </strong></td>
<td class="t hnormal "><xsl : val ue-of sel ect="n:startDateTi me" /></td>
</tr>
<tr>
<td cl ass="t hnormal "><strong>Fi ne: </strong></td>
<td class="thnormal ">$<xsl : val ue-of select="n:fine" /></td>
</tr>
</ xsl : tenpl at e>
</ xsl : styl esheet >
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KEN Notifications

This document provides information about the attributes of a Natification. These attributes are elements
such as message content, who is sending the natification, who should receive it, etc. Kuali Enterprise
Notification (KEN) supports an arbitrary number of Content Types, such as a simple message or an event
notification. Each Content Type consists of acommon set of attributes and a content attribute.

Common Notification Attributes

Table 2.4. Common Notification Attributes

Name

Type

Required

Description

Example

channel

string

yes

e Name of a
channel

* Must be
registered

Library Events

producer

string

yes

* Name of the
producing
system

e Must be
registered  and
given authority
to send messages
on behalf of
the <Library
Events> channel

Library  Calendar
System

senders

alist of strings

yes

A list of the names
of people on whose
behalf the message
is being sent

TestUserl,
TestUser2

recipients

alist of strings

yes

A list of the names
of groupsor usersto
whom the message
is being sent

library-staff-group,
TestUserl,
TestUser2

deliveryType

string

yes

fyi or ack

fyi

sendDateTime

datetime

no

When to send the
notification

2006-01-01
00:00:00.0

autoRemoveDateTin

réatetime

no

Whentoremovethe
notification

2006-01-02
00:00:00.0

priority

string

yes

An arbitrary
priority; these must
be registered in
KEN; the system
comes with defaults
of normal, low, and
high

normal

contentType

string

yes

Name for the
content; KEN

simple
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Name Type Required Description Example

comes set up with
simple and event;
new contentTypes
must be registered
in KEN

content see below yes The actual content |see below

Message Content

Notifications are differentiated using the contentType attribute and the contents of the content element.
The content element can be as simple as a message string or it may be a complex structure. For example,
a simple natification may only contain a message string, whereas an Event Content Type might contain
a summary, description, location, and start and end dates and times. Examples of the Smple and Event
Content Types:

Sample XML for a Simple Notification

<?xm version="1. 0" encodi ng="UTF-8"?>

<I-- ASinple Notification Message -->

<notification xm ns="ns:notification/NotificationRequest"
xm ns: xsi =http://ww. w3. or g/ 2001/ XM_.Schena- i nst ance
xsi : schemalLocati on="ns: notification/NotificationRequest
resource: notification/NotificationRequest">
<I-- this is the nane of the notification channel -->
<l-- that has been registered in the system-->
<channel >Canpus St at us Announcenent s</ channel >

<l-- this is the name of the producing system-->
<l-- the value nust match a registered producer -->
<pr oducer >Canpus Announcenents Systenx/ producer>

<l-- these are the people that the nessage is sent on -->
<l-- behalf of -->
<sender s>

<sender >John Fer ei r a</ sender >
</ sender s>

<l-- who is the notification going to? -->
<reci pi ent s>

<gr oup>Ever yone</ gr oup>

<user >j af 30</ user >
</reci pi ent s>

<l-- fyi or acknow edge -->
<del i veryType>fyi </ deliveryType>

<l-- optional date and tine that a notification should be sent -->
<l-- use this for scheduling a single future notification to happen -->
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<sendDat eTi me>2006- 01- 01T0O0: 00: 00</ sendDat eTi ne>

<l-- optional date and tine that a notification should be renoved -->
<l-- fromall recipients' lists, b/c the nessage no |onger applies -->
<aut oRenoveDat eTi me>3000- 01- 01T00: 00: 00</ aut oRenoveDat eTi nme>

<l-- this is the name of the priority of the nmessage -->
<l-- priorities are registered in the system so your value -->
<l-- here must match one of the registered priorities -->

<priority>Normal </priority>

<titl e>School is Cosed</title>

<l-- this is the name of the content type for the nmessage -->
<l-- content types are registered in the system so your value -->
<l-- here nmust match one of the registered contents -->

<cont ent Type>Si npl e</ cont ent Type>

<l-- actual content of the nessage -->

<content xm ns="ns:notification/ContentTypeSi npl e"
xsi : schemalLocati on="ns: notifi cati on/ Content TypeSi npl e
resource: notification/ Content TypeSi npl e">

<message>Snow Day! School is closed. </ nessage>
</ cont ent >
</notification>

Sample XML for an Event Notification

<?xm version="1. 0" encodi ng="UTF-8"?>

<notification xm ns="ns:notification/NotificationMessage"
xm ns: xsi ="http://ww. w3. or g/ 2001/ XM_Schema- i nst ance"
xsi : schemalLocati on="ns: notification/NotificationMessage
resource: notification/NotificationMessage">
<l-- this is the nane of the notification channel -->
<l-- that has been registered in the system-->
<channel >Concerts Conmi ng to Canpus</channel >

<l-- this is the name of the producing system-->
<l-- the value nust match a registered producer -->
<pr oducer >Canpus Events O fi ce</ producer >

<l-- these are the people that the nessage is sent on -->
<!-- behalf of -->
<sender s>
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<sender >ag266</ sender >
<sender >j af 30</ sender >
</ sender s>

<l-- who is the notification going to? -->
<reci pi ent s>
<gr oup>G oup X</ group>
<gr oup>G oup Z</ group>
<user >ag266</ user >
<user >j af 30</ user >
<user >ar hl4</ user >
</reci pi ent s>

<l-- fyi or acknow edge -->
<del i veryType>fyi </ deliveryType>

<l-- optional date and tine that a notification should be sent -->
<l-- use this for scheduling a single future notification to happen -->
<sendDat eTi ne>2006- 01- 01 00: 00: 00. O</ sendDat eTi ne>

<l-- optional date and tine that a notification should be renoved -->
<l-- fromall recipients' lists, b/c the nessage no |onger applies -->
<aut oRenoveDat eTi me>2007- 01- 01 00: 00: 00. 0</ aut oRenoveDat eTi ne>

<l-- this is the name of the priority of the nessage -->
<l-- priorities are registered in the system so your value -->
<l-- here must match one of the registered priorities -->

<priority>Normal </priority>

<l-- this is the name of the content type for the nmessage -->
<l-- content types are registered in the system so your value -->
<l-- here nmust match one of the registered contents -->

<cont ent Type>Event </ cont ent Type>

<l-- actual content of the nessage -->
<content >
<nmessage>CCC presents The Strokes at Cornell </ nessage>

<l-- an event that it happening on canpus -->

<event xm ns="ns:notification/ContentEvent"
xsi : schenmalLocati on="ns: notification/ Cont ent Event
resource: notification/ContentEvent">
<summar y>CCC presents The Strokes at Cornell </ summary>
<descri pti on>bl ah bl ah bl ah</descri pti on>
<l ocation>Barton Hall </l ocati on>
<start Dat eTi me>2006- 01-01TO0O: 00: 00</ st art Dat eTi ne>
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<st opDat eTi me>2007- 01- 01T0O: 00: 00</ st opDat eTi me>
</ event >
</ cont ent >
</notification>

Notification Response

When KEN sends a notification, it always returns aresponse. Thisisan outlinein XML of that response:

<?xm version="1.0" encodi ng="UTF-8"7?>
<r esponse>

<st at us>success</ st at us>
</ response>

Enterprise Notification Priority

Managing Priorities

KEN

There is no user interface page to manage priorities so you must make changes to the list of prioritiesin
thekren_prio_t table using SQL.

The table has these columns:

Table2.5. KREN_PRIO_T

Name Type Max Size Required Attribute
PRIO_ID Numeric 8 Yes ID

NM Text 40 Yes Name
DESC _TXT Text 500 Yes Description
PRIO_ORD Numeric 4 Yes Order
VER_NBR Numeric 8 Yes Version

Example 2.1. Example— Thisisan example of how to add a Priority into the table:

I NSERT | NTO kren_prio_t (PRIOID, NV DESC TXT, PRIO ORD, VER NBR) VALUES (8,

Delivery Types

This section describes Kuali Enterprise Notification (KEN) Delivery Types, or what are sometimes called
Message Deliverers. A Message Deliverer Plugin is the mechanism used to deliver a notification to end
users. All notifications sent through KEN appear in the Action List for each recipient for which the
notification is intended. This message aso contains an Email Delivery Type that allows you to send end
users a notification summary as an email message. Note that for a Delivery Type other than the default
(KEWActionList), the content of the notification is typically just a summary of the full notification.

Implementing the Java Interface

Creating a new Dedivery Type primarily involves implementing a Java interface called
org.kuali.rice.kew.deliverer .NotificationM essageDeliver er. The source code of the interface:
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/*
* Copyright 2007 The Kuali Foundati on
*
* Licensed under the Educational Conmunity License, Version 2.0 (the "License");
* you may not use this file except in conpliance with the License.
* You may obtain a copy of the License at
*
* http://ww. opensource. org/licenses/ecl 2. php
*
* Unless required by applicable |aw or agreed to in witing, software
* distributed under the License is distributed on an "AS I S" BASI S,
* W THOUT WARRANTI ES OR CONDI TI ONS OF ANY KIND, either express or inplied
* See the License for the specific | anguage governi ng perm ssions and
* [imtations under the License.
*/

package org. kuali.rice. ken.deliverer

i mport java.util.HashMap;

i mport java.util.LinkedHashMap;

i mport org. kuali.rice.ken.bo.NotificationMessageDelivery;

i mport org. kuali.rice.ken.exception. ErrorlList;

i mport org. kuali.rice.ken.exception.Notificati onAut oRenoveExcepti on

i mport org. kuali.rice.ken.exception.Notificati onMessageDel iveryException
i mport org.kuali.rice.ken.exception.NotificationMessageD sm ssal Exception

/**

* This class represents the different types of Notification Delivery Types that t
* For exanple, an instance of delivery type could be "ActionList" or "Email" or ™"
* adhering to this interface can be plugged into the systemand will be automatic
* @uthor Kuali Rice Team (kuali-rice@oogl egroups. con

*/

public interface Notificati onMessageDeliverer {
/**
* This method is responsible for delivering the passed i n nessageDelivery recor
* @aram nessageDel i very The nessageDelivery to process
* @hrows NotificationMessageDeliveryException
*/

public void deliverMessage(Notificati onMessageDel i very nmessageDel i very) throws N
/**
* This met hod handl es auto renoving a nessage delivery froma person's list o
* @aram nessageDel i very The nmessageDelivery to auto renove
* @hrows NotificationAut oRenmbveExcepti on
*/
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public void aut oRenbveMessageDel i very(Noti fi cati onMessageDel i very nessageDel i ver
/**

* This method di snmi sses/renoves the Notificati onMessageDelivery so that it is
via this deliverer. Note, whether this action is neaningful is dependent o
deliverer cannot control the presentation of the nmessage, then this nethod
@ar am nessageDel i very the nmessageDel ivery to dism ss
@aram the user that caused the dismissal; in the case of end-user actions,

whi ch the nmessage was delivered (user recipient in the Notificati onMessag
@ar am cause the reason the nessage was di sm ssed

E I I I

public void di sm ssMessageDel i very(Notificati onMessageDel i very messageDel i very,

KEN: Sending a Notification

The Kuali Enterprise Natification system (KEN) provides for a way to programmaticaly send a
notification. An application may construct a notification using the KEN web service API.

Send a Notification Using the Web Service API

To send a notification using the web service API, the notification must be constructed as an XML
document that validates agai nst aschemafor aspecific Content Type. For more detail, seethe Notifications
documentation.

To validate your notification XML, you must construct the XSD schema filename. To construct this file
name, append the Content Type value to ContentType.

For example, if you create anew Content Typefor alibrary book overdue notification, then the contentType
element value should be OverdueNotice and the schemafile you created for validation of the notification
XML should be Content TypeOver dueNotice.xsd. This XML schema should be declared as a namespace
inthe content element of the notification XML. Out of the box, KEN comeswith Smple and Event Content
Types.

Web Service URL

By default, the Notification Web Service APl may be accessed at: http://yourlocalip:8080/natification/
services/Notification

A WSDL may be obtained using the following URL: http://yourlocalip:8080/notification/services/
Notification?2wsdl

Note

In the URL s above, replace yourlocalip with the hostname where KEN is deployed.

Exposed Web Services

Initially, KEN exposes a web service method to send a notification. The sendNotification method is a
simple String In/String Out method. It accepts one parameter (notificationMessageAsXml) and returns a
notificationResponse as a String. For the format of the response, see the Notification Response document
inthe TRG for KEN.
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Calling the sendNotification Service from JAVA
First, create a String that includes the XML content for the notification, as described in the Naotification
Message document of the TRG for KEN. In the following example code, the XML representation
of the notification is read as a file from the file system in the main method, and the code calls the
MySendNotification method to invoke the Notification web service.

A SOAP style web services binding stub is available in the notification.jar file, as described above in
the Dependencies section.

Y ou may use this code as atemplate for sending a notification using the web service:

package edu.cornell.library.notification;

i mport org.apache. comons.io. |l QUtils;

i mport org. kuali.notification.client.ws.stubs. Notificati onWbServiceSoapBi ndi ngStu

i mport java.io.| OException;

i mport java.io.lnputStream
i mport java. net. URL;

public class MyNotificati onWwbServi ced ient {

private final static String WEB SERVICE URL = "http://I ocal host: 8080/ notificati

public static void MySendNotification(String notificati onMessageAsXm ) throws Ex

URL url = new URL(WEB_SERVI CE_URL);

Noti fi cati onWebSer vi ceSoapBi ndi ngSt ub stub = new Notifi cati onWWbServi ceSoapBi n
String responseAsXm = stub.sendNotification(notificationMessageAsXm );

/1 do sonething useful with the response
System out. printl n(responseAsXm );

}

public static void main(String[] args) {

I nput Stream notificationXM. = MyNotificationWebServiceC ient.class. get Resource

String notificati onMessageAsXm = ;

try {
notificati onMessageAsXm = 1OQUtils.toString(notificationXMW);

} catch (1 CException ioe) {

t hrow new Runti meException("Error | oadi ng webservice_notification.xm");

}

try {
MySendNot i fi cation(notificati onMessageAsXm );

} catch (Exception ioe) {
t hrow new Runti meException("Error runni ng webservice");

}
}

40



KEN

KEN Authentication
Web

KEN can support any Web Sign On technology that results in the population of the HttpServletRequest
remote user variable, exposed via the getRemoteUser accessor.

publicjava.lang.String getRemoteUser ()

Returns the login of the user making this request, if the user has been authenticated, or null if the user
has not been authenticated. Whether the user name is sent with each subsequent request depends on the
browser and type of authentication.

Returns: A String specifying the login of the user making this request, or null

The generic KEN release comes configured with CAS.

Web Services

Web service authentication is part of the development process and is not implemented by the standalone
release of Rice. The notification web service is Axis-based.
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Chapter 3. KEW

What is Kuali Enterprise Workflow?

What is workflow, in general?

What is Kuali Enterprise Workflow, in particular?
What problems or functions does KEW solve?
What problems does KEW NOT solve?

With which applications can KEW integrate?

Can | use KEW without building an entire application?
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Chapter 4. KIM

Terminology
Principal

Entity

Group

Permission
Responsibility

Role

Reference Information

Services
Using the Services

ldentityManagementService
Retrieving Principal Information
Retrieving Entity Default Information
Retrieving Reference Information
Retrieving Group Membership Information
Retrieving Group Information
Checking Permission

Retrieving Permission Information
Checking Responsibility

Retrieving Responsibility Information
Checking Authentication
RoleManagementService
Checking Role Assignment
Retrieving Role Information

Updating Role Membership

Person Service

Retrieving Personal Information

KIM Types

Implementing Custom KIM Types
KIM Group Type Service

KIM Permission Type Service
KIM Responsibility Type Service
KIM Role Type Service
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Chapter 5. KNS
KNS Configuration Guide




Chapter 6. KSB
KSB Configuration Guide
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Glossary
A

Action List

Action List Type

Action Request

Action Request Hierarchy

Action Requested

Action Taken

A list of the user's notification and workflow items. Also called the user's
Notification List. Clicking an item in the Action List displays details about that
notification, if the item is a natification, or displays that document, if it is a
workflow item. The user will usually load the document from their Action Listin
order to take the requested action against it, such as approving or acknowledging
the document.

Thistellsyou if the Action List item is a notification or a more specific workflow
request item. When the Action List item is a notification, the Action List Typeis
"Notification."

A request to a user or Workgroup to take action on a document. It designates the
type of action that is requested, which includes:

» Approve: requests an approve or disapprove action.

» Complete: requests a completion of the contents of a document. This action
request is displayed in the Action List after the user saves an incomplete
document.

» Acknowledge: requests an acknowledgment by the user that the document has
been opened - the doc will not leave the Action List until acknowledgment has
occurred; however, the document routing will not be held up and the document
will be permitted to transaction into the processed state if neccessary.

» FYI: anctification to the user regarding the document. Documents requesting
FY| can be cleared directly from the Action List. Even if a document has FY|
reguests remaining, it will still be permitted to transition into the FINAL state.

Action requests are hierarchical in nature and can have one parent and multiple
children.

Theaction one needsto take on adocument; also thetype of action that isrequested
by an Action Request. Actions that may be requested of a user are:

» Acknowledge: requests that the users states he or she has reviewed the
document.

» Approve: requests that the user either Approve or Disapprove a document.

» Complete: requests the user to enter additional information in a document so
that the content of the document is complete.

* FYI: intended to simply makes a user aware of the document.

An action taken on a document by a Reviewer in response to an Action Request.
The Action Taken may be:

» Acknowledged: Reviewer has viewed and acknowledged document.

» Approved: Reviewer has approved the action requested on document.
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Blanket Approved: Reviewer has requested a blanket approval up to aspecified
point in the route path on the document.

Canceled: Reviewer has canceled the document. The document will not be
routed to any more reviewers.

Cleared FY|: Reviewer has viewed the document and cleared all of his or her
pending FYI(s) on this document.

Completed: Reviewer has completed and supplied all data requested on
document.

Created Document: User has created a document

Disapproved: Reviewer has disapproved the document. The document will not
being routed to any subsequent reviewers for approval. Acknowledge Requests
are sent to previous approvers to inform them of the disapproval.

Logged Document: Reviewer has added a message to the Route Log of the
document.

Moved Document: Reviewer has moved the document either backward or
forward in its routing path.

Returned to Previous Node: Reviewer has returned the document to a previous
routing node. When a Reviewer does this, all the actions taken between the
current node and the return node are removed and all the pending requests on
the document are deactivated.

Routed Document: Reviewer has submitted the document to the workflow
engine for routing.

Saved: Reviewer has saved the document for later completion and routing.

Superuser Approved Document: Superuser has approved the entire document,
any remaining routing is cancelled.

Superuser Approved Node: Superuser has approved the document through all
nodes up to (but not including) a specific node. When the document getsto that
node, the normal Action Requests will be created.

Superuser Approved Request: Superuser has approved a single pending
Approve or Complete Action Request. The document then goes to the next
routing node.

Superuser Cancelled: Superuser has canceled the document. A Superuser can
cancel a document without a pending Action Request to him/her on the
document.

Superuser Disapproved: Superuser has disapproved the document. A Superuser
can disapprove a document without a pending Action Request to him/her on
the document.
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Activated
Activation

Activation Type

Active Indicator

Ad Hoc Routing

Annotation

Approve

Approver

Attachment

Attribute Type

Authentication

Authorization

Author Universal 1D

 Superuser Returned to Previous Node: Superuser has returned the document
to a previous routing node. A Superuser can do this without a pending Action
Request to him/her on the document.

The state of an action request when it is has been sent to auser’s Action List.
The process by which requests appear in auser's Action List

Defines how a route node handles activation of Action Requests. There are two
standard activation types:

e Sequential: Action Requests are activated one at a time based on routing
priority. The next Action Request isn't activated until the previous request is
satisfied.

» Pardle: All Action Requests at the route node are activated immediately,
regardless of priority

An indicator specifying whether an object in the system is active or not. Used as
an aternative to complete removal of an object.

A type of routing used to route a document to users or groups that are not in the
Routing path for that Document Type. When the Ad Hoc Routing is complete, the
routing returns to its normal path.

Optional comments added by a Reviewer when taking action. Intended to explain
or clarify the action taken or to advise subsequent Reviewers.

A type of workflow action button. Signifies that the document represents avalid
business transaction in accordance with institutional needs and policies in the
user's judgment. A single document may require approval from several users, at
multiple route levels, before it movesto final status.

The user who approves the document. As a document moves through Workflow,
it movesoneroute level at atime. An Approver operates at a particular route level
of the document.

The pathname of a related file to attach to a Note. Use the "Browse..." button to
open thefile dialog, select the file and automaticaly fill in the pathname.

Used to strongly type or categorize the values that can be stored for the various
attributes in the system (e.g., the value of the arbitrary key/value pairs that can be
defined and associated with a given parent object in the system).

The act of logging into the system. The Out of the box (OOTB) authenticaton
implementation in Rice does not require a password as it is intended for testing
puposesonly. Thisissomething that must be enabled aspart of animplementation.
Various authentication solutions exist, such as CAS or Shibboleth, that an
implementer may want to use depending on their needs.

Authorization is the permissions that an authenticated user has for performing
actionsin the system.

A free-form text field for the full name of the Author of the Note, expressed as
"Lastname, Firstname Initial"
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B

Base Rule Attribute

Blanket Approval

Blanket Approve Workgroup

Branch

Business Rule

C

Campus
Campus Type

Cancel

The standard fields that are defined and collected for every Routing Rule These
include:

» Active: A trueffase flag to indicate if the Routing Ruleis active. If false, then
the rule will not be evaluated during routing.

» Document Type: The Document Type to which the Routing Rule applies.

* From Date: The inclusive start date from which the Routing Rule will be
considered for a match.

» Force Action: atrue/false flag to indicate if the review should be forced to take
action again for the requests generated by thisrule, even if they had taken action
on the document previously.

» Name: the name of therule, this serves asaunique identifier for therule. If one
is not specified when the ruleis created, then it will be generated.

* Rule Template: The Rule Template used to create the Routing Rule.

» To Date: Theinclusive end date to which the Routing Rule will be considered
for amatch.

Authority that is given to designated Reviewerswho can approve a document to a
chosen route point. A Blanket Approval bypasses approvals that would otherwise
be required in the Routing For an authorized Reviewer, the Doc Handler typically
displaysthe Blanket Approval button along with the other options. When aBlanket
Approval is used, the Reviewers who are skipped are sent Acknowledge requests
to notify them that they were bypassed.

A workgroup that has the authority to Blanket Approve a document.

A path containing one or more Route Nodes that a document traverses during
routing. When a document enters a Split Node multiple branches can be created.
A Join Node joins multiple branches together.

1. Describes the operations, definitions and constraints that apply to an
organization in achieving its goals.

2. A restriction to a function for a business reason (such as making a specific
object code unavailable for a particular type of disbursement). Customizable
business rules are controlled by Parameters.

Identifies the different fiscal and physical operating entities of an institution.
Designates a campus as physical only, fiscal only or both.

A workflow action available to document initiators on documents that have not
yet been routed for approval. Denotes that the document is void and should be
disregarded. Canceled documents cannot be modified in any way and do not route
for approval.
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Canceled

CAS - Central Authentication
Service

Client

Client/Server

Close

Comma-separated value
Complete

Completed

Country Restricted Indicator

Creation Date

csv

D

Date Approved

Date Finalized

Deactivation

Delegate

Delegate Action List

A routing status. The document is denoted as void and should be disregarded.

http://www.jasig.org/cas - An open source authentication framework. Kuali Rice
provides support for integrating with CAS as an authentication provider (among
other authentication solutions) and also provides an implementation of a CAS
server that integrates with Kuali Identity Management.

A Java Application Program Interface (API) for interfacing with the Kuali
Enterprise Workflow Engine.

The use of one computer to request the services of another computer over a
network. The workstation in an organization will be used to initiate a business
transaction (e.g., abudget transfer). This workstation needs to gather information
from a remote database to process the transaction, and will eventually be used to
post new or changed information back onto that remote database. The workstation
isthus a Client and the remote computer that houses the database is the Server.

A workflow action available on documents in most statuses. Signifies that the
user wishes to exit the document. No changes to Action Requests, Route Logs or
document status occur as aresult of a Close action. If you initiate adocument and
close it without saving, it isthe same as canceling that document.

A file format using commas as delimiters utilized in import and export
functionality.

A pending action request to a user to submit a saved document.

The action taken by a user or group in response to a reguest in order to finish
populating a document with information, as evidenced in the Document Route
Log.

Field used to indicate if a country is restricted from use in procurement. If there
is no value then thereis no restriction.

The date on which a document is created.

See comma-separ ated value

The date on which a document was most recently approved.

The date on which adocument entersthe FINAL state. At thispoint, all approvals
and acknowledgments are complete for the document.

The process by which requests are removed from a user's Action List

A user who has been registered to act on behalf of another user. The Delegate
acts with the full authority of the Delegator. Delegation may be either Primary
Delegation or Secondary Delegation.

A separate Action List for Delegate actions. When a Delegate selects a Delegator
for whomto act, an Action List of all documents sent to the Delegator is displayed.

For both Primary and Secondary Delegation the Delegate may act on any of the
entries with the full authority of the Delegator.
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Disapprove

Disapproved

Doc Handler

Doc Handler URL
Doc Nbr

Document

Document Id
Document Number

Document Operation

Document Search

Document Status

Document Title

Document Type

A workflow action that allowsauser to indicate that adocument does not represent
a valid business transaction in that user's judgment. The initiator and previous
approvers will receive Acknowledgment requests indicating the document was
disapproved.

A status that indicates the document has been disapproved by an approver as a
valid transaction and it will not generate the originally intended transaction.

The Doc Handler is aweb interface that a Client uses for the appropriate display
of adocument. When a user opens a document from the Action List or Document
Search, the Doc Handler manages access permissions, content format, and user
options according to the requirements of the Client.

The URL for the Doc Handler.

See Document Number .

Also see E-Doc.

An electronic document containing information for a business transaction that is
routed for Actionsin KEW. It includes information such as Document ID, Type,
Title, Route Status, Initiator, Date Created, etc. In KEW, adocument typically has
XML content attached to it that is used to make routing decisions.

See Document Number .

A unique, sequential, system-assigned number for a document

A workflow screen that provides an interface for authorized users to manipulate
the XML and other data that defines a document in workflow. It alows you
to access and open a document by Document 1D for the purpose of performing
operations on the document.

A web interface in which users can search for documents. Users may search by
a combination of document properties such as Document Type or Document 1D,
or by more specialized properties using the Detailed Search. Search results are
displayedin alist similar to an Action List.

See also Route Status.

Thetitle given to the document when it was created. Depending on the Document
Type, thistitle may have been assigned by the I nitiator or built automatically based
on the contents of the document. The Document Title is displayed in both the
Action List and Document Search.

The Document Type defines the routing definition and other properties for a set
of documents. Each document is an instance of a Document Type and conducts
the same type of business transaction as other instances of that Document Type.

Document Types have the following characteristics:
» They are specifications for a document that can be created in KEW
» They contain identifying information as well as policies and other attributes

» They defines the Route Path executed for a document of that type (Process
Definition)
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Document Type Hierarchy

Document Type Label
Document Type Name

Document Type Policy

Drilldown

Dynamic Node

E

ECL

E-Doc
eDocLite

Embedded Client

Employee Status
Employee Type
Entity

Entity Attribute

e They are hierarchical in nature may be part of a hierarchy of Document Types,
each of which inherits certain properties of its Parent Document Type.

» They are typically defined in XML, but certain properties can be maintained
from agraphical interface

A hierarchy of Document Type definitions. Document Types inherit certain
attributes from their parent Document Types. This hierarchy is also leveraged by
various pieces of the system, including the Rules engine when evaluating rule sets
and KIM when evaluating certain Document Type-based permissions.

The human-readabl e label assigned to a Document Type.
The assigned name of the document type. It must be unique.

These advise various checks and authorizations for instances of aDocument Type
during the routing process.

A link that allows a user to access more detailed information about the current
data. These links typically take the user through a series of inquiries on different
business objects.

An advanced type of Route Node that can be used to generate complex routing
paths on the fly. Typically used whenever the route path of a document cannot be
statically defined and must be completely derived from document data.

1. Anacronym for Educational Community License.

2. All Kuali software and material is available under the Educational Community
License and may be adopted by colleges and universities without licensing
fees. The open licensing approach a so provides opportunities for support and
implementation assistance from commercial affiliates.

An abbreviation for electronic documents, adso a shorthand reference to
documents created with eDocL.ite.

A framework for quickly building workflow-enabled documents. Allows you to
define document screensin XML and render them using XSL style sheets.

A type of client that runs an embedded workflow engine.

Found on the Person Document; defines the employee's current employment
classification (for example, "A" for Active).

Found on the Person Document; definesthe employee's position classification (for
example, "P" for Professional).

An Entity record houses identity information for agiven Person, Process, System,
etc. Each Entity is categorized by its association with an Entity Type.

Entitieshavedirectory-likeinformation called Entity Attributesthat are associated
with them

Entity Attributes make up the identity information for an Entity record.
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Entity Type

Exception

Exception Messaging

Exception Routing

Extended Attributes

Extension Rule Attribute

F

Field Lookup

Fina
Flexible Route Management
FlexRM  (Flexible Route

Module)

Force Action

Provides categorization to Entities. For example, a“ System” could be considered
an Entity Type because something like a batch process may need to interfact with
the application.

A workflow routing status indicating that the document routed to an exception
gueue because workflow has encountered a system error when trying to process
the document.

The set of services and configuration options that are responsible for handling
messages when they cannot be successfully delivered. Exception Messaging is
set up when you configure KSB using the properties outlined in KSB Module
Configuration.

A type of routing used to handle error conditions that occur during the routing
of a document. A document goes into Exception Routing when the workflow
engine encounters an error or a situation where it cannot proceed, such as a
violation of a Document Type Policy or an error contacting external services.
When this occurs, the document is routed to the parties responsible for handling
these exception cases. This can be a group configured on the document or a
responsibility configured in KIM. Once one of these responsible parties has
reviewed the situation and approved the document, it will be resubmitted to the
workflow engine to attempt the processing again.

Custom, table-driven business object attributes that can be established by
implementing institutions.

One of the rule attributes added in the definition of a rule template that extends
beyond the base rule attributes to differentiate the routing rule. A Required
Extension Attribute has its "Required" field set to True in the rule template.
Otherwise, it isan Optional Extension Attribute. Extension attributesare typically
used to add additional fields that can be collected on arule. They also define the
logic for how those fields will be processed during rule evaluation.

The round magnifying glass icon found next to fields throughout the GUI that
allow the user to look up reference table information and display (and select from)
alist of valid values for that field.

A workflow routing status indicating that the document has been routed and has
no pending approval or acknowledgement requests.

A standard KEW routing scheme based on rules rather than dedicated table-based
routing.

The Route Module that performs the Routing for any Routing Rule is defined
through FlexRM. FlexRM generates Action Requests when a Rule matches the
datavalue contained in adocument. An abbreviation of "Flexible Route Module."
A standard KEW routing schemethat isbased on rules rather than dedicated table-
based routing.

A trueffalse flag that indicates if previous Routing for approval will be ignored
when an Action Request is generated. The flag is used in multiple contexts where
requests are generated (e.g., rules, ad hoc routing). If Force Action is False, then
prior Actions taken by a user can satisfy newly generated requests. If it is True,
then the user needs to take another Action to satisfy the request.

53



Glossary

Group

Group Attribute

H

Hierarchical Tree Structure

Initialized

Initiated

Initiator

Inquiry

J

Join Node

A workflow action request that can be cleared from a user's Action List with
or without opening and viewing the document. A document with no pending
approval reguests but with pending Acknowledge requestsisin Processed status.
A document with no pending approval requests but with pending FY| requestsis
in Final status. See also Ad Hoc Routing and Action Request.

A Group has members that can be either Principals or other Groups (nested).
Groups essentially become away to organize Entities (via Principal relationships)
and other Groups within logical categories.

Groups can be given authorization to perform actions within applications by
assigning them as members of Roles.

Groups can also havearbitrary identity information (i.e., Group Attributes hanging
from them. Group Attributes might be values for "Office Address," "Group
Leader," etc.

Groups can be maintained at runtime through a user interface that is capable of
workflow.

Groups have directory-like information called Group Attributes hanging from
them. "Group Phone Number" and "Team Leader" are examples of Group
Attributes.

Group Attributes make up the identity information for a Group record.

Group Attributes can be maintained at runtime through a user interface that is
capable of workflow.

A hierarchical representation of datain agraphical form.

The state of an Action Request when it is first created but has not yet been
Activated (sent to auser’s Action List).

A workflow routing status indicating a document has been created but has not
yet been saved or routed. A Document Number is automatically assigned by the
system.

A user role for a person who creates (initiates or authors) a new document for
routing. Depending on the permissions associated with the Document Type, only
certain users may be able to initiate documents of that type.

A screen that allows a user to view information about a business object.

The point in the routing path where multiple branches are joined together. A Join
Node typically has a corresponding Split Node for which it joins the branches.
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K

KC - Kuali Coeus

KCA -
Affiliates

Kuali Commercid

KCB — Kuai Communications
Broker

KEN - Kuai Enterprise
Notification
KEW — Kuali Enterprise
Workflow

KFS—Kuali Financial System

KIM -
Management

Kuali  Identity

KNS —Kuali Nervous System

KPP - Kuali Partners Program

TODO

A designation provided to commercia affiliates who become part of the Kuali
Partners Program to provide for-fee guidance, support, implementation, and
integration services related to the Kuali software. Affiliates hold no ownership of
Kuali intellectual property, but are full KPP participants. Affiliates may provide
packaged versions of Kuali that provide value for installation or integration
beyond the basic Kuali software. Affiliates may also offer other types of training,
documentation, or hosting services.

KCB islogically related to KEN. It handles dispatching messages based on user
preferences (email, SMS, etc.).

A key component of the Enterprise Integration layer of the architecture
framework. Its features include:

» Automatic Message Generation and Logging
» Messageintegrity and delivery standards
» Dedlivery of notificationsto auser’s Action List

Kuali Enterprise Workflow is a general-purpose el ectronic routing infrastructure,
or workflow engine. It manages the creation, routing, and processing of electronic
documents (eDocs) necessary to complete a transaction. Other applications can
also use Kuali Enterprise Workflow to automate and regul ate the approval process
for the transactions or documents they create.

Deliversacomprehensive suite of functionality to servethe financial system needs
of al Carnegie-Classinstitutions. An enhancement of the proven functionality of
Indiana University's Financial Information System (FIS), KFS meets GASB and
FASB standards while providing a strong control environment to keep pace with
advancesin both technol ogy and business. Modulesincludefinancial transactions,
genera ledger, chart of accounts, contracts and grants, purchasing/accounts
payable, labor distribution, budget, accounts receivable and capital assets.

A Kuali Rice module, Kuali Identity Management provides a standard API for
persons, groups, roles and permissions that can be implemented by an institution.
It also provdies an out of the box reference implementation that alows for a
university to use Kuali astheir Identity Management solution.

A core technical module composed of reusable code components that provide
the common, underlying infrastructure code and functionality that any module
may employ to perform its functions (for example, creating custom attributes,
attaching electronic images, uploading data from desktop applications, lookup/
search routines, and database interaction).

The Kuali Partners Program (KPP) is the means for organizations to get involved
in the Kuali software community and influence its future through voting rights to
determine software devel opment priorities. Membership dues pay staff to perform
Quality Assurance (QA) work, release engineering, packaging, documentation,
and other work to coordinate the timely enhancement and release of quality
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KRAD - Kudi Rapid
Application Development
KRMS - Kuai Rules
Management System

KS- Kuali Student

KSB —Kuali Service Bus

Kudli

Kuali Foundation

Kuali Rice

software and other services valuableto the members. Partners are al so encouraged
to tender functional, technical, support or administrative staff members to the
Kuali Foundation for specific periods of time.

TODO

TODO

Deliversameansto support students and other users with astudent-centric system
that provides real-time, cost-effective, scalable support to help them identify
and achieve their goals while smplifying or eliminating administrative tasks.
The high-level entities of person (evolving roles-student, instructor, etc.), time
(nested units of time - semesters, terms, classes), learning unit (assigned to any
learning activity), learning result (grades, assessments, evaluations), learning
plan (intentions, activities, major, degree), and learning resources (instructors,
classrooms, equipment). The concierge function is a self-service information
sharing system that aligns information with needs and tasks to accomplish goals.
The support for integration of locally-devel oped processes providesflexibility for
any institution's needs.

Provides an out-of-the-box service architecture and runtime environment for Kuali
Applications. It is the cornerstone of the Service Oriented Architecture layer of
the architectural reference framework. The Kuali Service Bus consists of :

* A servicesregistry and repository for identifying and instantiating services
 Run time monitoring of messages
 Support for synchronous and asynchronous service and message paradigms

1. Pronounced "ku-wah-leg". A partnership organization that produces a suite of
community-source, modular administrative software for Carnegie-class higher
education institutions. See also Kuali Foundation

2. (n.) A humble kitchen wok that plays an important role in asuccessful kitchen.

Employs staff to coordinate partner efforts and to manage and protect the
Foundation's intellectual property. The Kuali Foundation manages a growing
portfolio of enterprise software applications for colleges and universities. A
lightweight Foundation staff coordinates the activities of Foundation members
for critical software development and coordination activities such as source code
control, release engineering, packaging, documentation, project management,
software testing and quality assurance, conference planning, and educating and
assisting members of the Kuali Partners program.

Provides an enterprise-class middleware suite of integrated products that allow
both Kuali and non-Kuali applications to be built in an agile fashion, such
that developers are able to react to end-user business requirements in an
efficient manner to produce high-quality business applications. Built with Service
Oriented Architecture (SOA) concepts in mind, KR enables developers to build
robust systems with common enterprise workflow functionality, customizable
and configurable user interfaces with a clean and universal look and feel, and
genera notification features to allow for a consolidated list of work "action
items." All of this adds up to providing a re-usable development framework that
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L

Last Modified Date

M

Maintenance Document

Message

Message Queue

Namespace

Note Text

Notification Content
O0TB

Optimistic Locking

encourages a simplified approach to developing true business functionality as
modular applications.

The date on which the document was last modified (e.g., the date of the last action
taken, the last action request generated, the last status changed, etc.).

An e-doc used to establish and maintain atable record.

The full description of a notification message. Thisis a specific field that can be
filled out as part of the Simple Message or Event Message form. This can also
be set by the programmatic interfaces when sending notifications from a client
system.

Allows administrators to monitor messages that are flowing through the Service
Bus. Messages can be edited, deleted or forwarded to other machines for
processing from this screen.

A Namespace is a way to scope both Permissions and Entity Attributes Each
Namespace instance is one level of scoping and is one record in the system.
For example, "KRA" or "KFS" could be a Namespace. Or you could further
break those up into more finer grained Namespaces such that they would roughly
correlate to functional moduleswithin each application. Examples could be"KRA
Rolodex", "KRA Grants', "KFS Chart of Accounts'.

Out of the box, the system is bootstrapped with numerous Rice namespaces
which correspond to the different modules. There is also a default namespace of
“KUALI".

Namespaces can maintained at runtime through a maintenance document.

A free-form text field for the text of a Note

This section of a notification message which displays the actual full message for
the notification along with any other content-type-specific fields.

Stands for "out of the box" and refers to the base deliverable of a given feature
in the system.

A type of “locking” that is placed on a database row by a process to prevent
other processes from updating that row before the first process is complete. A
characteristic of this locking technique is that another user who wants to make
modifications at the same time as another user is permitted to, but the first one
who submits their changes will have them applied. Any subsequent changes will
result in the user being notified of the optimistic lock and their changes will not
be applied. Thistechnique assumes that another update is unlikely.
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Optiona Rule Extension
Attribute

Org Doc #

Organization

Organization Code

P

Parameter Component Code
Parameter Description

Parameter Name
Parameter Type Code

Parameter Value

Parent Document Type

Parent Rule

Permission

An Extension Attribute that is not required in a Rule Template. It may or may
not be present in a Routing Rule created from the Template. It can be used as
a conditional element to aid in deciding if a Rule matches. These Attributes are
simply additional criteriafor the Rule matching process.

The originating document number.

Refers to a unit within the institution such as department, responsibility center,
campus, etc.

Represents aunique identifier assigned to units at many different levelswithin the
institution (for example, department, responsibility center, and campus).

Code identifying the parameter Component.
Thisfield houses the purpose of this parameter.

This will be used as the identifier for the parameter. Parameter values will be
accessed using this field and the namespace as the key.

Code identifying the parameter type. Parameter Type Code isthe primary key for
its' table.

This field houses the actual value associated with the parameter.

A Document Type from which another Document Type derives. Thechild typecan
inherit certain properties of the parent type, any of which it may override. A Parent
Document Type may have a parent as part of a hierarchy of document types.

A Routing Rulein KEW from which another Routing Rule derives. The child Rule
can inherit certain properties of the parent Rule, any of which it may override. A
Parent Rule may have a parent as part of a hierarchy of Rules.

Permissions represent fine grained actions that can be mapped to functionality
within a given system. Permissions are scoped to Namespace which roughly
correlate to modules or sections of functionality within a given system.

A developer would code authorization checks in their application against these
permissions.

Some examples would be: "canSave", "canView", "canEdit", etc.
Permissions are aggregated by Roles.

Permissions can be maintained at runtime through a user interface that is capable
of workflow; however, developers still need to code authorization checks against
them in their code, once they are set up in the system.

Attributes

1. Id - a system generated unique identifier that is the primary key for any
Permission record in the system

2. Name - the name of the permission; also a human understandable unique
identifier
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Person Identifier

Person Role

Pessimistic Locking

Plugins

Post Processor

Posted Date/Time Stamp

Postal Code

Preferences

Primary Delegation

Principal

3. Description - afull description of the purpose of the Permission record
4. Namespace - the reference to the associated Namespace
Relationships

1. Permission to Role - many to many; this relationship ties a Permission record
to aRolethat is authorized for the Permission

2. Permission to Namespace - many to one; this relationship allows for scoping
of a Permission to a Namespace that contains functionality which keys its
authorization checking off of said

The username of an individual user who receives the document ad hoc for the
Action Requested

Creates or maintains the list used in selection of personnel when preparing the
Routing Form document.

A type of lock placed on a database row by a process to prevent other processes
from reading or updating that row until thefirst processisfinished. Thistechnique
assumes that another update is likely.

A plugin is a packaged set of code providing essential services that can be
deployed into the Rice standalone server. Plugins usually contains only classes
used in routing such as custom rules or searchable attributes, but can contain
client application specific services. They are usually used only by clients being
implemented by the ‘ Thin Client’ method

A routing component that is notified by the workflow engine about various events
pertaining to the routing of a specific document (e.g., node transition, status
change, action taken). Theimplementation of aPost Processor istypically specific
to aparticular set of Document Types. When all required approvalsare completed,
the engine notifiesthe Post Processor accordingly. At this point, the Post Processor
is responsible for completing the business transaction in the manner appropriate
to its Document Type.

A free-formtext field that identifies the time and date at which the Notesis posted.
Defines zip code to city and state cross-references.

User optionsinan Action List for displaying thelist of documents. Users can click
the Preferences button in the top margin of the Action List to display the Action
List Preferences screen. On the Preferences screen, users may change the columns
displayed, the background colors by Route Status, and the number of documents

displayed per page.

The Delegator turns over full authority to the Delegate. The Action Requests
for the Delegator only appear in the Action List of the Primary Delegate. The
Delegation must be registered in KEW or KIM to be in effect.

A Principal represents an Entity that can authenticate into the system. One can
roughly correlateaPrincipal to alogin username. Entitiescan existin KIM without
having permissions or authorization to do anything; therefore, a Principal must
exist and must be associated with an Entity in order for it to have access privileges.
All authorization that is not specific to Groupsistied to aPrincipal.
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Processed

Recipient Type

Required Rule Extension
Attribute

Responsibility

Responsibility 1d

Responsible Party

Reviewer

Rice

Role

Route Header Id

Route Log

Route Module

Route Node

In other words, an Entity isfor identity whileaPrincipal isfor access management.

Also note that an Entity is allowed to have multiple Principals associated with
it. The use case typically given here is that a person may apply to a school and
receive one log in for the application system; however, once accepted, they may
receive their official login, but use the same identity information set up for their
Entity record.

A routing status indicating that the document has no pending approval requests
but still has one or more pending acknowledgement requests.

Thetype of entity that is receiving an Action Request. Can be a user, workgroup,
or role.

An Extension Attribute that is required in a Rule Template. It will be present in
every Routing Rule created from the Template.

See Responsible Party.

A unique identifier representing a particular responsibility on a rule (or from a
route module Thisidentifier staysthe samefor aparticular responsibility no matter
how many times aruleis modified.

The Reviewer defined on a routing rule that receives requests when the rule
is successfully executed. Each routing rule has one or more responsible parties
defined.

A user acting on adocument in his/her Action List and who hasreceived an Action
Request for the document.

An abbreviation for Kuali Rice.

Roles aggregate Permissions When Roles are given to Entities (via their
relationship with Principals) or Groups an authorization for all associated
Permissions is granted.

Another name for the Document | d.

Displays information about the routing of a document. The Route Log is usually
accessed from either the Action List or a Document Search. It displays general
document information about the document and a detailed list of Actions Taken
and pending Action Requests for the document. The Route Log can be considered
an audit trail for adocument.

A routing component that the engine usesto generate action requests at aparticul ar
Route Node. FIexRM (Flexible Route Module) is a general Route Module that
is rule-based. Clients can define their own Route Modules that can conduct
speciaized Routing based on routing tables or any other desired implementation.

Represents a step in the routing process of a document type. Route node
"Iinstances" are created dynamically asadocument goesthroughitsrouting process
and can be defined to perform any function. The most common functions are to
generate Action Requests or to split or join the route path.
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Route Path

Route Status

Routed By User

Routing

Simple: do some arbitrary work

Requests: generate action requests using a Route Module or the Rules engine
Split: split the route path into one or more parallel branches

Join: join one or more branches back together

Sub Process. execute another route path inline

Dynamic: generate a dynamic route path

The path a document follows during the routing process. Consists of a set of
route nodes and branches. The route path is defined as part of the document type
definition.

The status of a document in the course of its routing:

Approved: These documents have been approved by all required reviewers and
are waiting additional postprocessing.

Cancelled: These documents have been stopped. The document’ s initiator can
‘Cancel’ it before routing begins or a reviewer of the document can cancel it
after routing begins. When a document is cancelled, routing stops; it is not sent
to another Action List.

Disapproved: These documents have been disapproved by at |east onereviewer.
Routing has stopped for these documents.

Enroute: Routing is in progress on these documents and an action request is
waiting for someone to take action.

Exception: A routing exception has occurred on this document. Someone from
the Exception Workgroup for this Document Type must take action on this
document, and it has been sent to the Action List of this workgroup.

Final: All required approvals and all acknowledgements have been received on
these documents. No changes are allowed to a document that isin Final status.

Initiated: A user or a process has created this document, but it has not yet been
routed to anyone’ s Action List.

Processed: These documents have been approved by all required users, and is
completed on them. They may be waiting for Acknowledgements. No further
action is needed on these documents.

Saved: These documents have been saved for later work. An author (initiator)
can save a document before routing begins or areviewer can save a document
before he or she takes action on it. When someone saves a document, the
document goes on that person’s Action List.

The user who submits the document into routing. This is often the same as the
Initiator. However, for some types of documents they may be different.

The process of moving a document through its route path as defined in its
Document Type. Routing is executed and administered by the workflow engine.
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Routing Priority

Routing Rule

Rule Attribute

This process will typically include generating Action Requests and processing
actionsfrom the userswho receive those requests. In addition, the Routing process
includes callbacksto the Post Processor when there are changesin document state.
A number that indicates the routing priority; asmaller number hasahigher routing
priority. Routing priority is used to determine the order that requests are activated
on aroute node with sequential activation type.

A record that containsthe datafor the Rule Attributes specified in aRule Template
It is an instance of a Rule Template populated to determine the appropriate
Routing. The Rule includes the Base Attributes, Required Extension Attributes,
Responsible Party Attributes, and any Optional Extension Attributes that are
declared in the Rule Template. Rules are evaluated at certain pointsin the routing
process and, when they fire, can generate Action Requests to the responsible
parties that are defined on them.

Technical considerations for a Routing Rules are:

 Configured viaa GUI (or imported from XML)

 Created against a Rule Template and a Document Type

e The Rule Template and it's list of Rule Attributes define what fields will be
collected in the Rule GUI

 Rules define the users, groups and/or roles who should receive action requests
» Available Action Request Types that Rules can route

e Complete

e Approve

* Acknowledge

* FYI

 During routing, Rule Evaluation Sets are “selected” at each node. Default isto
select by Document Type and Rule Template defined on the Route Node

* Rules match (or ‘fire’) based on the evaluation of data on the document and
data contained on the individual rule

» Examples
« |f dollar amount isgreater than $10,000 then send an Approval request to Joe.

e If depatment is “HR” request an Acknowledgment from the
HR.Acknowledgers workgroup.

Rule attributes are acore KEW data el ement contained in adocument that controls
its Routing. It participatesin routing as part of a Rule Template and is responsible
for defining custom fields that can be rendered on a routing rule. It also defines
the logic for how rules that contain the attribute data are evaluated.

Technical considerations for a Rule Attribute are:
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Rule QuickLinks

Rule Template

Save

Saved

Searchable Attributes

» They might be backed by a Java class to provide lookups and validations of
appropriate values.

» Define how a Routing Rule evaluates document data to determine whether or
not the rule data matches the document data.

» Definewhat datais collected on arule.

» Anattribute typically correspondsto one piece of dataon adocument (i.edollar
amount, department, organization, account, etc.).

» Can be written in Java or defined using XML (with matching done by X Path).
» Can have multiple GUI fields defined in asingle attribute.

A list of document groups with their document hierarchies and actions that can be
selected. For specific document types, you can create the rule delegation.

A Rule Template serves as a pattern or design for the routing rules. All of the
Rule Attributes that include both Required and _Optional_ are contained in the
Rule Template; it defines the structure of the routing rule of FlexRM. The Rule
Template is also used to associate certain Route Nodes on a document type to
routing rules.

Technical considerations for a Rule Templates are:
e They are acomposition of Rule Attributes

» Adding a‘Role attribute to a template allows for the use of the Role on any
rules created against the template

» When rule attributes are used for matching on rules, each attribute is associated
with the other attributes on the template using an implicit ‘and’ logic qualifier

» Can be used to define various other aspects to be used by the rule creation GUI
such as rule data defaults (effective dates, ignore previous, available request
types, etc)

A workflow action button that allows the Initiator of a document to save their
work and close the document. The document may be retrieved from the initiator's
Action List for completion and routing at alater time.

A routing status indicating the document has been started but not yet completed or
routed. The Save action allows theinitiator of a document to save their work and
close the document. The document may be retrieved from theinitiator's action list
for completion and routing at alater time.

Attributesthat can be defined to index certain pieces of dataon adocument so that
it can be searched from the Document Search screen.

Technical considerations for a Searchable Attributes are:

» They areresponsible for extracting and indexing document data for searching
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Secondary Delegation

Service Registry

Simple Node

SOA

Specia Condition Routing

Split Node

Spring

State

Status

Submit

Superuser

Superuser Approval

Superuser Document Search

e They alow for custom fields to be added to Document Search for documents
of aparticular type

» They are configured as an attribute of a Document Type

» They can be written in Java or defined in XML by using Xpath to facilitate
matching

The Secondary Delegate acts as atemporary backup Delegator who acts with the
same authority as the primary Approver/the Delegator when the Delegator is not
available. Documents appear in the Action Lists of both the Delegator and the
Delegate. When either acts on the document, it disappears from both Action Lists.

Secondary Delegation is often configured for a range of dates and it must be
registered in KEW or KIM to bein effect.

Displaysaread-only view of all of the servicesthat are exposed on the Service Bus
and includesinformation about them (for example, P Address, or Endpoint URL).

A type of node that can perform any function desired by the implementer. An
example implementation of a simple node is the node that generates Action
Requests from route modules.

An acronym for Service Oriented Architecture.

Thisisageneric term for additional route levelsthat might betriggered by various
attributes of atransaction. They can be based on the type of document, attributes of
the accounts being used, or other attributes of the transaction. They often represent
special administrative approvals that may be required.

A node in the routing path that can split the route path into multiple branches.

The Spring Framework is an open source application framework for the Java
platform.

Defines U.S. Postal Service codes used to identify states.

On an Action List; aso known as Route Status. The current location of the
document in its routing path.

A workflow action button used by the initiator of a document to begin workflow
routing for that transaction. It moves the document (through workflow) to the next
level of approval. Once a document is submitted, it remainsin 'ENROUTE' status
until all approvals have taken place.

A user who has been given special permission to perform Superuser Approvals
and other Superuser actions on documents of a certain Document Type.

Authority given Superusers to approve a document of a chosen Route Node. A
Superuser Approval action bypasses approvals that would otherwise be required
in the Routing. It is available in Superuser Document Search. In most cases,
reviewers who are skipped are not sent Acknowledge Action Requests.

A special mode of Document Search that allows Superusers to access documents
in a specia Superuser mode and perform administrative functions on those
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T

Thread pool

Title

Viewer

W

Web Service Client

Wildcard

Workflow

Workflow Engine

Workflow QuickLinks

documents. Access to these documents is governed by the user's membership in
the Superuser Workgroup as defined on a particular Document Type.

A technique that improves overall system performance by creating a pool of
threadsto execute multiple tasks at the sametime. A task can execute immediately
if athread in the pool is available or else the task waits for a thread to become
available from the pool before executing.

A short summary of the notification message. This field can be filled out as part
of the Simple Message or Event Message form. In addition, this can be set by the
programmatic interfaces when sending notifications from a client system.

Thisfield is equivalent to the "Subject" field in an email.

An acronym for Uniform Resource L ocator.

A person who can log in and use the application. This term is synonymous with
“Principal” in KIM.

A user(s) who views a document during the routing process. This includes users
who have action reguests generated to them on a document.

A type of client that connects to a standalone KEW server using Web Services.

A character that may be substituted for any of a defined subset of all possible
characters.

Electronic document routing, approval and tracking. Also known as Workflow
Services or Kuali Enterprise Workflow (KEW). The Kuali infrastructure service
that electronically routes an e-doc to its approvers in a prescribed sequence,
according to established business rules based on the e-doc content. See also Kuali
Enterprise Workflow.

The component of KEW that handles initiating and executing the route path of a
document.

A web interface that provides quick navigation to various functions in KEW.
These include:

* Quick EDoc Watch: Thelast five Actionstaken by thisuser. The user can select
and repeat these actions.

* Quick EDoc Search: Thelast five EDocs searched for by thisuser. The user can
select one and repeat that search.
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XML

XML Ingester

XML RuleAttribute

e Quick Action List: Thelast five document types the user took action with. The
user can select one and repeat that action.

See also XML Ingester.

1. Anacronym for Extensible Markup Language.

2. Used for data import/export.

A workflow function that allows you to browse for and upload XML data.

Similar in functionality to a RuleAttribute but built using XML only
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